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Installing an Exinda Virtual Appliance

The Exinda range of unified performance management (UPM) appliances is available as fully featured virtual appliances.
There is no difference between the software that runs on bare metal hardware and the software that runs on the virtual
appliance. If the Exinda software detects itis running on a hypervisor, it automatically enables certain optimizations to
ensure maximum performance.

Exinda provides support for Virtual Appliances running on the following hypervisors:

» VMware vSphere (ESX and ESXi) (5.5 and 6.0)

= Citrix XenServer (6.2 and 6.5)

= Microsoft Hyper-V (Windows Server 2008 R2 and later)

= Linux KYM (Intel VT or AMD-V)

Exinda Appliances deploy the same ways as hardware appliances. For more information refer to Deployment options.

The two typical deployment topologies are in-path and out-of-path.

0.1 Overview of in-path deployment

In-path deployments involve one or more LAN/WAN port pairs bridged together at layer 2. To be monitored and
optimized by an Exinda Virtual Appliance, traffic must go through the bridge.

In an in-path topology, an Exinda Virtual Appliance is deployed inline. Using an image of a hardware appliance to
represent a virtual appliance, an inline Exinda Virtual Appliance plugs into the network via the LAN and WAN ports like
this:
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Screenshot 1:Inline deployment

The challenge in a virtual environment is deciding how to pass traffic through the bridge. The method you choose
depends on your virtual environment and hypervisor.

There are several options:
» Dedicate two physical NICs on the host to be LAN and WAN ports.
» Used shared NICs on the host to be LAN and WAN ports, but logically separate the traffic with VLAN tags.

» Create a virtual network and direct traffic through virtual LAN/WAN ports.

0.2 Overview of out-of-path deployment

Out-of-path deployments are typically used in SPAN port mirroring, WCCP, high availability (HA) and clustering scenarios.
Using an image of a hardware appliance to represent a virtual appliance, an Exinda Virtual Appliance plugs into the
network like this:
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Screenshot 2: Out-of-path deployment
The setup is straightforward, requiring one NIC for management and another for auxiliary.

See the following topic for more information about installing and running an Exinda Virtual Appliance.



Virtual Appliance Deployment Options

Virtual Appliances can be deployed in all the same ways hardware appliances can. There are generally two typical
deployment topologies, in line and out-of-path. Inline deployments involve one or more LAN/WAN port pairs bridged
together at layer 2. Traffic must be directed through the bridge in order to be Monitored and Optimized.

Using a hardware appliance as an example, here is what an inline deployment looks like:

Legend
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Screenshot 3: Inline deployment

The challenge in a virtual environment is how to pass traffic through the bridge. There are several options:

» Dedicate 2 physical NICs on the host to be LAN and WAN ports.

» Used shared NICs on the host to be LAN and WAN ports, but logically separate the traffic with VLAN tags.

» Create a virtual network such that traffic is directed through virtual LAN/WAN ports.

How this is best achieved largely depends on the virtual environment and which hypervisor technology is used.

Out-of-path deployments are typically used in SPAN port mirroring, WCCPv2, HA and Clustering scenarios. Using a
hardware appliance as an example, here is what an out-of path deployment looks like:

Legend

@ Switch
@ Router

Screenshot 4: Out-of-path deployment

This is quite straight forward to setup in a virtual environment, you need one NIC for Management and another NIC for
Auxiliary

Exinda supports a virtualization solution for most of the following hypervisor solutions:

= VMware ESX/ESXi versions 5.5 and 6.0

e

= Citrix XenServer versions 5.5, 5.6,and 6.0

e

= Microsoft Hyper-V Windows 2008 R2, 2012, and 2012 R2
= LInux KYM

e

This document provides an overview of the supported Exinda deployments for its virtualization solution, and includes
the following information:
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Diagrams of each supported deployment,

Lists of supported software versions,

Recommendations for sizing (CPU, Memory, and storage),
Limitations for each hypervisors, where applicable,

Reference links for supporting material.



Sizing and resource requirements

Exinda supports:

» 50Mbps to 10Gbps for Diagnostics

= 20Mbpsto 10Gbps for Diagnostics and Shaping

» 1Mbps to 1Gbps for Diagnostics, Shaping, and Acceleration

NOTE

The recommended CPU is the minimum number of CPUs to achieve the performance numbers. The CPU must be
VT Enabled & 64-bit.

The Exinda virtual appliance has a Flexible Storage option, with which you can adjust the size of the storage for Edge
Cache, SMB1 cache and WAN Memory cache. By increasing the virtual file sizes for each of these caches, you can greatly
improve the performance of your Exinda virtual appliance.

For Edge Cache and SMB1 Cache there is no limit to the size of the file created on the external storage. Use common
sense when creating the file sizes. Exinda recommends that 80% of the actual file size be allocated to Edge Cache and
SMB1 Cache. For example, if your SMB1 cache is 1TB then the recommendation is 800MB.

For WAN Memory, size should be based on the following:
» For systems with 2GB RAM — Max WAN Memory Cache is 300GB
»  For all other systems — Max WAN Memory Cache is 1TB

Depending on the WAN bandwidth, use the following sizing specifications to estimate the host resources required for
each of the Exinda virtual appliances.

Virtual Appli- Diagnostics Diagnostics Diagnostics, Shap- Virtual Minimum Minimum
ance and Shap- ing, and Accel- CPUs RAM Disk Stor-
ing eration (Qty x age
GHz)
VM Small Up to 150 Up to 50 Up to 10 Mbps 4 x 6GB 250GB
Mbps Mbps 2.0GHz
VM Medium Uptol Up to 500 Up to 20 Mbps 4 X 8GB 250GB
Gbps Mbps 24GHz
VM Large Upto5s Upto5s Up to 200 Mbps 8 X 32GB 500GB
Gbps Gbps 24GHz
VM Extra Large Up to 10 Up to 10 Up to 1 Gbps 12-24 64GB 1TB
Gbps Gbps X
24GHz
VM Extra Extra Upto 15 Upto15 Up to 1 Gbps 12-24 128GB 178
Large Gbps Gbps X
24GHz
NOTE

On the Exinda Virtual Appliance 10063, the number of CPUs depends on the licensed bandwidth for Diagnostics,
Shaping, and Acceleration.



NOTE

In the case of Minimum Disk Storage, storage at higher throughput will require higher disk /0 bandwidth, so the
underlying storage should be RAID-based, ideally RAID 10.

IMPORTANT
There are several factors that may mean more or fewer resources are required in individual environments.
Factors that may have an effect include:

= Quality, speed, performance of the host CPUs.
» Quality and performance of host NICs.

= Host disk I/O bandwidth.

Use these topics for more guidance on sizing, specifications and resource requirements:

s

i

e

e

]

et

]

VM Small

VM Medium

VM Large

VM Extra Large

VM Extra Extra Large

0.3 Exinda Virtual Appliance model VM Small specifications

Requirement Details

Diagnostics Licensed Bandwidth (in 150M
mbps)

Diagnostics and Shaping Licensed 50M
Bandwidth (in mbps)

Diagnostics, Shaping, and 5M 10M
Acceleration Licensed Bandwidth

(in mbps)

Max Concurrent Flows 150,000

Max L7 New Connection Rate 4,000

Maximum Accelerated Connections 2,000

Reports 20
SLAs 100
APS Objects 100
Policies 512
Edge Cache Max Throughput (in 20

mbps)



Requirement Details

Default Bridge (Interface)

CPUs (Qty x GHz)

Minimum Storage (GB)
Minimum Memory (GB)
EC-IOPS

Monitoring-IOPS

br1 (eth1, eth2)/bypass
br3 (eth3, eth4)/bypass

2 % 2.0GHz

NOTE

All virtual machine models must be run on hosts with Intel® Xeon® class CPUs. CPU ratings
requirements are as quoted in the table. These CPUs must be VT Enabled and 64-Bit

250GB
6GB
50

150

0.4 Exinda Virtual Appliance model VM Medium specifications

Specification Details

Diagnostics Licensed Bandwidth
(in gbps)

Diagnostics and Shaping Licensed
Bandwidth (in mbps)

Diagnostics, Shaping, and
Acceleration Licensed Bandwidth
(in mbps)

Max Concurrent Flows

Max L7 New Connection Rate
Maximum Accelerated Connections
Reports

SLAs

APS Objects

Policies

Edge Cache Max Throughput
(Mbps)

Default Bridge (Interface)

CPUs (Qty x GHz)

Minimum Storage (GB)
Minimum Memory (GB)
EC-IOPS

Monitoring-IOPS

1G

100M 250M 500M

20M

220,000
10,000
4,500
60

250
250

1,024

br10 (eth10, eth11)/bypass

4 x 24Ghz

NOTE

All virtual machine models must be run on hosts with Intel® Xeon® class CPUs. CPU ratings
requirements are as quoted in the table. These CPUs must be VT Enabled and 64-Bit

250GB
8GB
50

150



0.5 Exinda Virtual Appliance model VM Large specifications

Specification Details

Diagnostics Licensed Bandwidth (Gbps) 5G

Diagnostics and Shaping Licensed Bandwidth (Gbps) 3G 4G 5G
Diagnostics, Shaping, and Acceleration Licensed Bandwidth 100M 200M
(Mbps)

Max Concurrent Flows 1,200,000

Max L7 New Connection Rate 25,000

Maximum Accelerated Connections 20,000

Reports 100

SLAs 300

APS Objects 300

Policies 4,096

Edge Cache Max Throughput (Mbps) 175

CPUs (Qty x GHz)2 8 X 24GHz

Minimum Storage (GB) 500GB

Minimum Memory (GB) 32GB

EC-IOPS 80

Monitoring-IOPS 150

Default Bridge (interface) br10 (eth10, eth11)/bypass

0.6 Exinda Virtual Appliance model VM Extra Large specifications

Specification Details

Diagnostics Licensed 10G

Bandwidth (Gbps)

Diagnostics and Shaping 6G 7G 8G 10G
Licensed Bandwidth

Diagnostics, Shaping, and 300 400 500 1G
Acceleration Licensed

Bandwidth

Max Concurrent Flows 1,800,000

Max L7 New Connection Rate 30,000

Maximum Accelerated 30,000

Connections
Reports 100

SLAs 300



Specification Details

APS Objects
Policies

Edge Cache Max Throughput
(Mbps)

Default Bridge (Interface)

CPUs (Qty x GH2)

Minimum Storage (TB)
Minimum Memory (GB)
EC-IOPS

Monitoring-lOPS

300

4,096

250

br10 (eth10 eth11)/bypass

12 X 2.4 (<=300M3)
24 x 2.4 (>300M3)

NOTE

All virtual machine models must be run on hosts with Intel® Xeon® class CPUs. CPU ratings
requirements are as quoted in the table. These CPUs must be VT Enabled and 64-Bit

NOTE
On the EXNV-10063, the number of CPUs depends on the licensed bandwidth for Diagnostics,

Shaping, and Acceleration.

2TB
64GB
80

150

0.7 Exinda Virtual Appliance model VM Extra Extra Large specifications

Specification Details

Diagnostics Licensed
Bandwidth (Gbps)

Diagnostics and Shaping
Licensed Bandwidth

Diagnostics, Shaping, and
Acceleration Licensed
Bandwidth

Max Concurrent Flows
Max L7 New Connection Rate

Maximum Accelerated
Connections

Reports
SLAs

APS Objects
Policies

Default Bridge (Interface)

15

6G 7G 8G 10G

300 400 500 1G

1,800,000
30,000

30,000

100
300
300
4,096

br10 (eth10, eth11)/bypass



Specification Details

Edge Cache Max Throughput 250
(Mbps)
CPUs (Qty x GHz) 12 X 24 (<=300M3)

24 x 24 (>300M3)

NOTE

All virtual machine models must be run on hosts with Intel® Xeon® class CPUs. CPU ratings
requirements are as quoted in the table. These CPUs must be VT Enabled and 64-Bit

NOTE

On the EXNV-12063, the number of CPUs depends on the licensed bandwidth for Diagnostics,
Shaping, and Acceleration.

Minimum Storage (TB) 2TB
Minimum Memory (GB) 128GB
EC-IOPS 80

Monitoring-lOPS 150



Exinda Virtual Appliance use cases

Learn different ways of deploying the Exinda virtual appliance. These use cases cover both inline and out-of-path
deployments. All of the hypervisors referenced in this documentation support out-of-path deployments. Inline
deployments are supported on VMware vSphere and Citrix XenServer, but NOT on Microsoft Hyper-V.

0.8 Inline deployment with externally attached LAN

In this use case, the Exinda Virtual Appliance is set up for inline mode deployment with an externally attached LAN.
There are primarily two scenarios for inline deployment of the virtual appliance:

1. The LAN-side users and applications connect to the Exinda Virtual Appliance through a physical NIC interface.

2. The applications are virtualized and isolated on the same host as the Exinda, on the LAN side interface of the Exinda
Virtual Appliance.

This use case discusses the first scenario.
NOTE

This scenario is only possible using VMware vSphere (v5.5 and v6.0) and Citrix XenServer (v6.2 and v6.5) hosts.
Microsoft Hyper-V does not support inline deployments.

Scenario

Branch \ / Data Center \
=
‘u’M

&)
/ N /

» The branch users access virtualized local services (such as print, DHCP, and Active Directory).

I Hypervisor

Switch Switch

=N

Screenshot 5: Scenario details

»  Atleast two physical NIC interfaces are bridged together in the virtual Exinda Virtual Appliance.

» User connections from the branch office to the Data Center applications are in line through the Exinda Virtual Appli-
ance on both ends of the connections, and through external NIC interfaces.

» The Exinda provides diagnostic, shaping, and acceleration for all traffic in this configuration.

» Optionally, install the Exinda Virtual Appliance in a separate host in an inline mode configuration and connect
through an external switch.



Use Case

In this scenario the hypervisor configuration is done at either a branch office with virtual infrastructure, or in the data
center where the applications are running on the host VM. So, the local users accessing the WAN leverage the Exinda for
diagnostics, shaping, and acceleration.

vSphere Client Local LAN WAN
XenCenter Client e

Hyper-V

NICO NIC1 NIC2 NIC3

ETHO ETH1 [ ETH2 Bridged ETH3

Exinda VM %

Hypervisor

g |
o
(%]
g
:
2
w

Screenshot 6: Use-case for Inline deployment with externally attached LAN
In this use-case:
» The local LAN is sitting behind the hypervisor.

» The host has four NIC interfaces. NIC 0 is dedicated for management of the system and NIC 1 is idle or used for other
purposes.

= NIC2 and NIC3 are mapped to SW2 and SW3.
= SW2 and SW3 are mapped to Exinda Virtual Appliance ETH2 and ETHS3.

» ETH2 and ETH3 are mapped to NIC 2 and NIC 3,and are configured and bridged together by the Exinda virtual
appliance.

» The data path from a client on the local LAN goes through the Exinda virtual appliance in Inline Mode and out to the
WAN.

» Exinda Exinda Virtual Appliance software version is 7.4.2.

= This deployment works with either local or external storage.

0.9 Inline deployment with an isolated virtual LAN and virtual applications

In this use case, the Exinda Virtual Appliance is set up for an inline mode deployment with an isolated virtual LAN and
virtual applications. There are primarily two scenarios for inline deployment of the virtual appliance:



1. The LAN side users and applications connect to the Exinda Virtual Appliance through a physical NIC interface.

2. The applications are virtualized and isolated on the same host as the Exinda on the LAN side interface of the Exinda
Virtual Appliance.

This use case discusses the second scenario.
NOTE

This scenario is only possible using VMware vSphere (v5.5 and v6.0) and Citrix XenServer (v6.2 and v6.5) hosts.
Microsoft Hyper-V does not support inline deployments.

Scenario

Branch \ / Data Center \

G
/ N /

» Branch users access virtualized local services (such as print, DHCP, and Active Directory).

Switch Switch

=N

Screenshot 7: Scenario details

» One physical NIC interface is configured to the WAN side link.

» Two virtual switches are bridged together in the virtual Exinda Virtual Appliance. The first switch is on the LAN side;
the second one is for the WAN side. This results in isolating the applications behind the Exinda Virtual Appliance.

= Users connecting from the branch office to the Data Center applications are in line through the Exinda virtual
machine(s) on both ends of the connections and through a single external NIC interface to the WAN.

» The Exinda appliance provides Diagnostics, Shaping, and Acceleration for all traffic in this configuration.

Use-case

This configuration will be in either a branch office with virtual infrastructure, or in the data center where the applications
are running on the host VM and local users accessing the WAN leverage the Exinda for Diagnostics, Shaping, and
Acceleration.
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Screenshot 8: Use-case for Inline deployment with an isolated virtual LAN and virtual applications

» In the diagram above, a virtual LAN is isolated and sits behind the Exinda Virtual Appliance all running on the same
host hypervisor.

e

» The host has two NICs; NIC 0 is dedicated for management of the system and NIC 1 is idle or used for other purposes.

et

= All virtual application workloads are configured in the hypervisor to SW2.

e

= SW2 is configured to map to Exinda Virtual Appliance ETH2

e

= ETH2 is configured as part of a bridged connection defined as BR2.

e

= BR2 bridges NIC 2 and NIC 3 together in the Exinda virtual appliance. The data path for any application connected
to the SW2 virtual switch goes through the Exinda Virtual Appliance in inline mode through the ETH2/ETH3 bridged
configuration and out the NIC3 interface to the WAN.

» OPTIONAL: If this is a branch office with local users, configure local users to connect through the NIC2 physical inter-
face and SW2/ETH2 Exinda Virtual Appliance interface and out to the WAN. This require mapping a third NIC interface.

0.10 Out-of-band (WCCP) mode

You can set up your Exinda Virtual Appliance in out-of-band mode, using WCCP protocol for deployment. This
deployment is typical for customers who have chosen to redirect a percentage of their traffic for acceleration and traffic
shaping through the Exinda Virtual Appliance. In the event the Exinda Virtual Appliance fails, all traffic previously
redirected to the Exinda Virtual Appliance goes through un-optimized and un-accelerated.

Use Cases
»  QOut-of-band (WCCP) mode (VMware ESXi)
» Out-of-band and High Availability (PBR/VRRP) Mode



0.10.1 Out-of-band (WCCP) mode (VMware ESXi)

This configuration can be done either at a branch office with virtual infrastructure, or in the data center where the
application and local user traffic accessing the WAN is redirected to the Exinda Virtual Appliance for diagnostics, shaping,
and acceleration.

Scenario

» Branch users access local services (print, DHCP, Active Directory) that are virtualized.
» One physical NIC interface is dedicated for management of the virtual machines and hypervisor.

» One physical NIC interface is configured on the hypervisor for LAN access, and has a routed connection to the WAN
router.

» One physical NIC interface is configured and mapped to the AUX port on the Exinda Virtual Appliance.

» OPTIONAL: It is possible to configure and map all data traffic through a single NIC interface on the hypervisor; how-
ever, for performance reasons it is recommended to segment the un-optimized traffic from the optimized traffic.

» User access from the branch office to the Data Center applications has two paths:
s Path oneis directly to the WAN router, with no traffic shaping or acceleration.

= Path twois through the re-directed path invoked by the router (using WCCP) to the Exinda virtual appliance.
The traffic is optimized and accelerated.

» Traffic on the Data Center side has the same path as the branch side. Traffic that is selected to be optimized and
accelerated is redirected to the Exinda Virtual Appliance through WCCP on the WAN router.

» The Exinda provides Diagnostics, Shaping, and Acceleration for only redirected traffic in this configuration

Use Case
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Screenshot 9: Use-case for Out-of-band (WCCP) mode (VMware ESX))
In this use case:

» The virtual LAN with application servers (APP1 W2003 or 8 and APP2) are configured in the ESXi hypervisor on SW1
and mapped to NICT. They have a direct path the WAN router.

» The physical serveris a re-purposed Dell Server and has the following physical/logical interface mappings for illus-
tration purposes only (you are encouraged to select your own server):



ESXi Ethernet Ports NICO NICT NIC2

Exinda Ethernet Ports ETHO ETH1 ETH2

ESXi Virtual Switches SWO SW1 SW2

et

= The host has three NICs; NIC 0 is dedicated for management of the system.

e

= NIC 1 is dedicated to all virtual application workloads hosted on the ESXi.

e

= All virtual application workloads are configured in the ESXi to SW1.

e

= The Exinda Virtual Appliance is configured on SW2 virtual switch and is mapped to the NIC2 interface.

» The NIC2 interface has a direct connection to the WAN router, and is configured for WCCP GRE layer 3 mode
between the router and the Exinda Virtual Appliance.

» VMware version =55 and 6.0
» Exinda Virtual Appliance firmware version =749
» The data path for virtualized applications configured on SW1 takes two paths:
s Path one — un-optimized and un-accelerated traffic is forwarded directly to the WAN router through NICT.

= Path two — traffic to be optimized (traffic shaped) and accelerated traffic is forwarded to the router for redir-
ection through WCCP to the Exinda Virtual Appliance through NIC2/SW2 on the AUX port of the Exinda Virtual
Appliance.

» (Optional) Itis possible to configure and map all data traffic on SW1 and SW2 to the NIC1 interface; however, for per-
formance reasons it is recommended to segment the optimized traffic on its own NIC and virtual switch for per-
formance reasons, and in the event of failure of the Exinda Virtual Appliance.

0.10.2 Out-of-band and High Availability (PBR/VRRP) Mode

In this use case, there are multiple Exinda Virtual Appliances set up for out-of-band mode and configured for High

Availability. PBR is the protocol used for redirection while the appliances act as VRRP nodes. One Exinda acts as the

Master node, receiving all redirected traffic from the WAN router, and all remaining Exinda Virtual Appliances act as
Backup nodes in case the Master fails.

This deployment would be typical for customers who are choosing to redirect a percentage of their traffic for
acceleration and traffic shaping through the Exinda virtual appliances.

To configure PBR/VRRP on the Exinda Virtual Appliance, see VRRP with PBR.

This configuration would work in either a branch office with virtual infrastructure, or in a data center where the
application and local user traffic accessing the WAN is redirected to the Exinda virtual appliance for Diagnostics, Shaping,
and Acceleration.

Scenario

» Branch users access virtualized, local services (print, DHCP, Active Directory, etc.).
» One physical NIC interface is dedicated for management of the virtual machines and hypervisor.

» One physical NIC interface is configured on the hypervisor for LAN access, and has a routed connection to the WAN
router.

» One physical NIC interface is configured and mapped to the virtual switch that is connected to the virtual AUX ports
on all the Exinda Virtual Appliances.

= User access from the branch office to the Data Center applications has two paths:



= Path one is directly to the WAN router, with no traffic shaping or acceleration.

s Path twois through the re-directed path invoked by the router (using PBR) to the Exinda virtual appliances.
The traffic is received by the Exinda configured as the VRRP Master. In case of acceleration, the Exinda Virtual
Appliances have the capability to share load, this happens automatically and requires no user intervention.

= Traffic on the Data Center side has the same path as the branch side. Traffic that is selected to be optimized and
accelerated is redirected to the Exinda Virtual Appliance through PBR on the WAN router.

<

Use Case

vSphere Client
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Hyper-V Manager
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Screenshot 10: Use-case for Out-of-band and High Availability (PBR/VRRP) Mode
In this diagram:

» The virtual LAN with application servers (APP1 and APP2) are configured in the hypervisor on SW1 and mapped to
NIC1.They have a direct path the WAN router.

» For simplicity, both Exinda Virtual Appliances installed in the same host hypervisor. However, it is possible to install
Exinda Virtual Appliances on separate hypervisors to achieve physical high availability

» The host has three NICs; NIC 0 is dedicated for management of the system.

e

= NIC 1 is dedicated to all virtual application workloads hosted on the hypervisor

e

= All virtual application workloads are configured in the hypervisor to SW1.

e

= The Exinda Virtual Appliances are configured on SW2 virtual switch and are mapped to the NIC2 interface.

et

= The NIC2 interface has a direct connection to the WAN router, which configured for PBR redirection. For more
information refer to Deployment Topologies.

» Exinda Virtual Appliance firmware version =7.4.2.



0.11 Port mirroring/SPAN port Configuration

Port mirroring/SPAN port Configuration can be used to perform network audits as it provides great flexibility in restricted
and complex network environments.

In this use case, the Exinda Virtual Appliance is set up to monitor and collect traffic for only reporting only, without
installing the appliance in the inline mode. The appliance monitors and reports on all applications presented on the
SPAN/mirror port.

vSphere Client

XenCenter Client
Hyper-V Manager

Redirected Traffic via a SPAN port

NICO NIC1 NIC2

SWo Swi SW2

Appl

App2
MGMT Port v AUX Port

Exinda VM

8

Hypervisor

Screenshot 11: Use-case for Port mirroring/SPAN port Configuration
In this use-case:

» The Exinda Virtual Appliance is used for monitoring and reporting, and is configured in the hypervisor to use the
dedicated NIC2 interface, and dedicated virtual switch SW2.

» The Exinda Virtual Appliance management port is mapped to SW0 and NICO.

» The Exinda Virtual Appliance has three Ethernet interfaces (ETHO-2) with the APP1 and APP2 both mapped to SW1
and NIC1, and connected to the external Switch.

» The AUX (ETHT) port is configured for SPAN port mirroring and management of the Exinda Virtual Appliance.

» The NIC2 interface is connected to an external switch on a port that has been configured to support SPAN port mir-
roring. It is recommended that this port be dedicated so there is no impact to traffic performance.

» Application virtual workloads (APP1 and APP2) are on a separate virtual SW1 and mapped to NIC1.
= NICT is directly attached to the external switch.

» The switch can also be a virtual one installed in the hypervisor.



Related topics
» Port mirroring with an external Nexus switch

= Port mirroring with a virtual Nexus switch

0.12 Port mirroring with an external Nexus switch

NOTE
in case of VMware, this configuration supports vMotion, HA, and Fault Tolerant.

External :
Mexus SW

Configured 8 SPAN port
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i
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Screenshot 12: Use-case for Port mirroring with an external Nexus switch
In this use-case:

» The customer has selected Exinda for its monitoring and reporting service. The EXN-V is configured as a virtual
machine on a hypervisor or as an ESXi hypervisor (for VMware), on a dedicated NIC2 interface, and dedicated virtual
switch SW2.

» The EXN-V management port is mapped to SWO and NICO.

» The host EXN-V has three four Ethernet interfaces (0-23) with the APP1-3 mapped to SW1 and NICT respectively,
and connected to the external Nexus Switch.

= The EXN-V with the AUX (ETH1) port is configured for SPAN Port Mirroring and management of the EXN-V.

» The NIC2 interface is connected to an external switch on a port that has been configured to support SPAN port mir-
roring. It is recommended that this port be dedicated so there is no impact to traffic performance.

»  Application virtual workloads (APP1 to 3) are on a separate virtual SW1 and mapped to NICT.

= NICT is directly attached to the external Nexus switch.



0.13 Port mirroring with a virtual Nexus switch

g |

EEETTE) Ness 1000 |

W— Configured as 5PAN port |

BT e ser A por
| Exinda VM

ESXi

Screenshot 13: Use-case for Port mirroring with a virtual Nexus switch

In this use-case:

0.13.1 VMware

NOTE
In this configuration VMware supports vMotion, HA, and Fault Tolerant.

= The Cisco Nexus 1000V Series VEM runs as part of the VMware ESX or ESXi kernel and replaces the Vmware Virtual
Switch functionality. The VEM uses the VMware vNetwork Distributed Switch (vDS) API, which was developed jointly by
Cisco and VMware, to provide advanced networking capability to virtual machines. This level of integration helps ensure
that the Cisco Nexus 1000V Series is fully aware of all server virtualization events, such as VMware VMotion and Dis-
tributed Resource Scheduler (DRS). The VEM takes configuration information from the VSM and performs Layer 2 switch-
ing and advanced networking functions namely Monitoring:

= NetFlow
s Switch Port Analyzer (SPAN)
s Encapsulated Remote SPAN (ERSPAN)

= VMware versions - 5.5 and 6.0

0.13.2 XenServer
» EXN-Vversions—749
» The Nexus 1000V is configured and mapped to NIC1, which has a direct connection to the WAN router.

» The EXN-V has two four Ethernet interfaces (ETHO / ETH10-3) with the AUX (ETH1) configured for Mirroring and
ETHO for management and management of the EXN-V.



» The EXN-V AUX port is configured to a port configured with SPAN port mirroring on the Nexus 1000V. This port
should be dedicated to ensure there is no performance impact to data traffic.

= The applications (APP1 to 3) are connected to a separate switch port on the Nexus 1000V.

0.14 VMware High Availability (HA)

In this use case, we discuss the recommended configuration and best practices for installing the Exinda virtual appliance
where the requirement is for:

» Exinda firmware - 74.9

= ESX/ESXi HA software versions 5.5 and 6.0

» vMotion support,

» vMotion = Yes for INLINE-line

» VMware best practice recommends that at least three hosts are used for this configuration, and

» Licensing for the Exinda Virtual Appliance units include two full licenses and one cold standby license.

Each Exinda Virtual Appliance must maintain network connectivity with the Exinda License server and will shut down
the Exinda virtual appliance after 96 hours without a successful connection.

— WAN
Router(s)

Exinda E;;”Iga Exinda
Primary HA Standby HA Primary
ESXi ESXi ESXi
APP APP APP APP APP APP APP APP APP
os os 0s o os 0s os s 0s os 0s
ESXi ESXi ESXi
Production N'etwork

Management Network (vMotion & HA)

vSphere

W

Server

Screenshot 14: Use-case for High Availability (HA) on VMware
In this use-case:
= There are six ESX/ESXi hosts (can be done with three):
= Two running virtual workloads, and a third as the backup HA system

= Tworunning Exinda Virtual Appliances and a third running as a cold standby



» Optionally you can move the Exinda Virtual Appliance to co-reside on the same hosts as the virtual workloads; how-
ever if vMotion is a requirement you must provide an external switch and separate NIC to pass the traffic between the
workloads and the Exinda Virtual Appliance.

» Having a separate host for the Exinda Virtual Appliance allows you to:

s Segment other virtual appliances from the application workloads.

= Support vMotion just for the application workloads and not for the host running the Exinda virtual appliance.
= There are two networks:

s A management network for vMotion and access to the external workload VMDK data stores.

= A production network for data traffic to and from the applications and WAN.
» This configuration assumes INLINE mode; optionally you can run in out of path mode, but WCCP is required.

» Downtime for any workload in HA mode is for the duration of the virtual workload and/or the Exinda Virtual Appli-
ance to reboot,

0.15 VMware Fault Tolerance (FT) cluster

In this use case, we discuss the recommended configuration and best practices for installing the Exinda Virtual
Appliance on VMware Fault Tolerance (FT) cluster. For this use-case, you require:

» Exinda firmware version — 749

» Hypervisor Fault Tolerance Cluster (software versions 5.5 and 6.0)

# vMotion support

» vMotion = Yes for INLINE

» VMware best practice recommends that at least 4 hosts are used for this configuration

» Licensing for the Exinda Virtual Appliance units will include one full license and one cold standby license.

s Fach Exinda Virtual Appliance must maintain network connectivity with the Exinda License server and will
shut down the Exinda virtual appliance after 96 hours without a successful connection.

» Optionally, the Exinda Virtual Appliance can co-reside with the Application workloads, but an external switch and an
additional NIC is required for vMotion support.
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Screenshot 15: Use-case for VMware Fault Tolerance (FT) cluster
In this use-case:
» There are four hypervisor hosts:
s one running virtual workloads and a second as the Fault Tolerance system
& one running Exinda Virtual Appliance active and a second running as a cold standby and Fault Tolerant.

» Optionally, move the Exinda Virtual Appliance to co-reside on the same hosts as the virtual workloads; however if vMo-
tion is a requirement you must provide an external switch and separate NIC to pass the traffic between the workloads
and the Exinda Virtual Appliance.

» Having a separate host for the Exinda Virtual Appliance allows you to:

s Segment other virtual appliances from the application workloads.

= Support vMotion just for the application workloads, and not for the host running the Exinda virtual appliance.
» There are two networks:

s A management network for vMotion and access to the external workload VMDK data stores

= A production network for data traffic to and from the applications and WAN

» This configuration assumes INLINE mode; optionally you can run in out of path mode which requires WCCP.



0.16 Virtual WAN simulator in anisolated network (VMware ESXi)
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Screenshot 16: Use-case for Virtual WAN simulator in an isolated network
In this use-case:
» The hypervisor has one NIC:

s NICO, NIC2, and NIC3 are unused

s NICT is connected to and external network and has access to the WAN for management and licensing of the
virtual machines.

NOTE
Any physical NIC interface can be used, NICT is used for illustration purposes.

» VMware software version =55 and 6.0
» Exinda Virtual Appliance firmware version =749
» WANEM Virtual Simulator software =2.3
= http//wanemsourceforge.net/
= You can use your own WAN simulator of choice
» Four virtual switches have been defined on the ESX/ESXi host:
# BR_LAN - branch side LAN switch
# BR_WAN - branch side WAN switch
= DC_WAN - data center side WAN switch
» DC_LAN —data center side LAN switch



» Each Exinda Virtual Appliance is configured for INLINE Mode and a single management interface on ETHO.
» DHCP is assumed on the network for management interfaces on the Exinda Virtual Appliance appliances.

» Private network space is configured for the Windows Client and Server on the data path between them and a
second Ethernet interface is configured for DHCP to manage each system through RDP.

»  Exinda Virtual Appliance and the WAN Simulator data path are bridged.

»  Optionally, you can configure the WAN Simulator as a router and change the default gateway of the clientand server
accordingly.

» Optionally with a system that has at least 3 NIC interfaces you can attach an external workstation and server and pass
traffic through the demo system.

= You will need to configure on the ESX/ESXi host mapping BR_LAN to NICO and DC_LAN to NIC3 to connect
the external workstation and server.

= The benefitis you can test through the isolated virtual Exinda Virtual Appliance environment with no impact
to a product network
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Screenshot 17: WAN external workstation



Hypervisor limitations

Consider these additional planning items when installing Exinda Virtual Appliance on other Hypervisors in the market
including:

» XenServer6.2,and 6.5
»  Microsoft Hyper-V on Windows 2008 R2,2012,and 2012 R2

0.16.1 XenServer

»  No Silicom Hardware Bypass Card driver support. Exinda is working with our NIC vendor to provide this support.

»  Promiscuous mode is supported, and must be configured via the CLI. You can find the commands in the Exinda Vir-
tualization How to Configure Guide, or refer to the Citrix site for XenServer hypervisor configuration guidance.

» Traffic shaping, reporting, and optimization are supported for INLINE mode.

» Reporting and optimization are supported for out of path (WCCP GRE) mode.

0.16.2 VMware
» Bypass NIC card drivers are supported in 5.5 and 6.0.

0.16.3 Hyper-V

» No support for Parallel virtualization drivers, meaning the guest machine does not know it's virtualized.

»  Only out-of-band deployments are supported for Hyper-V.

External storage is supported and recommended for virtual machine workloads, and the Exinda virtual appliance

In the diagram below, the Exinda is running in Active/Active mode with a Heartbeat between the two systems. There
must be a separate Virtual NIC configured for Heartbeat traffic to transit.

WAN <>~
Router(s) = =

APP | APP | Exinda |  Heartbeat | Exinda | APP | APP
o5 os VM VM o5 o5
Hypervisor Hypervisor
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Running on VMware vSphere (ESX and ESXi)

Learn how to run and customize the Exinda Virtual Appliance on VMware vSphere client.

NOTE
VMware ESX/ESXi 5.5 (or later) is required.

0.17 Understanding how VMotion works

For isolated virtual applications on the Exinda Virtual Appliance LAN port for inline mode, the VMware vMotion feature
does not work. It is a requirement from VMware that any virtual switch must be mapped to a physical NIC and then to an
external network. Below is a brief illustration of the process.

vMaotion live
migration =
NO

vMaotion live
migration =
NO

1

1 1

1 vMotion live vMotion live

! lotion five A APPL APP2 : otion five o1 APPL APP2

1 migration = i migration = -

1

, C ] | ]
1

: vSwitchl vSwitch2 1 vSwitchl vSwitch2

: i

=3 VMkemelSwitch1 X em Vikemne!Switchl X

l ESXi Host 1 l ESXi Host 2
NIC1 NICZ [~ NIC3 NIC1 NICZ [ NIC3 [—

Production Network

vMotion (Management) Network @

APP1_VMDK STeT
APPZ_VMDK || LEislEs:

» There are two types of virtual switches in the ESX/ESXi hypervisor: VMkernel Switch and vSwitch. The VMkernel
Switch is used by the hypervisor exclusively. VMkernel is the bare metal hypervisor, and provides core and memory alloc-
ation, disk and network virtualization, and a driver to low level devices. The vSwitch is used by virtual machines, and
behaves just like any external layer 2 switch. All virtual machines have a path to the external Data-store where each
VMDK is stored through the hypervisor layer to the VMkernel Switch mapped to the NIC attached to the storage.

» There are two networks:
a. Management network where vMotion moves workloads between ESXi hosts

b. Production network where the applications are accessed by the users
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# The VMkernelSwitch1 is mapped to external NICT and connected to the management network.
= The vSwitch1 is mapped to NIC2 and connects APP1 to the production network.

= The vSwitch2 is mapped to APP2 but does not have a mapping to external NIC3. The use case for this is that a net-
work administrator may have one, or many, virtual workloads isolated on the host for testing purposes.

= vMotion is executed for APP1 on ESXi 1 and moved over to ESXi 2 with no disruption to the application workload.

= vMotion is executed for APP2 on ESXi 1 and fails because vSwitch2 mapped to APP2 is not mapped to an external
NIC.

= If an Exinda Virtual Appliance has at least one vSwitch mapped toit, and the vSwitch is not mapped to an external
NIC interface, vMotion will not work for Exinda Virtual Appliance or workloads isolated behind it.

0.18 Install the Virtual Appliance on VMware

1. Liaise with your local Exinda representative to obtain the download files.
2. Open the VMware vSphere client.

3. Select File > Deploy OVF Template.

4. Copy the URL of the latest release of the Exinda VMware Virtual Appliance from Exinda.com, and paste it into the
Deploy from...field, and click Next.

5. Confirm the OVF template details are correct, and click Next.
6. Review and accept the End User License Agreement (EULA), and click Next.

7. Specify a name for the virtual appliance. If prompted, choose the location to deploy the virtual appliance, and click
Next.

8. Choose the format to store the virtual disks for the virtual appliance. Exinda recommends Thick Provisioning(the
default).

NOTE

By default, the Virtual Appliance is configured with a single 50GB disk. Additional storage can be added in the form
of another disk after the Virtual Appliance has been deployed. See the Additional Storage section for more
information.

9. Connect the network interfaces to the appropriate network, by doing the following:
a. Connect the Management interface to a network where you can manage the virtual appliance.

b. If you are configuring the virtual appliance for clustering, high availability, or out-of-path deployments, map
the AUX interface to the appropriate network. This interface can be left disconnected if it is not required.

c. If you are deploying the virtual appliance in line, add additional NICs.
4. Click Next.

5. Review the deployment settings, and click Finish to complete the deployment.

Related Topics
Review the following topics after completing the VM deployment:
= Adjusting the RAM available to the Virtual Machine

= Adjusting the NICs available to the Virtual Machine
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#» Add Storage to the VMware Virtual Machine

0.19 Modifying the VMware Virtual Machine Configuration

To improve the performance of the virtual appliance, change the number of CPUs, the RAM, networking, and storage
allocated to the virtual machine.

NOTE
You will need to shut the virtual appliance down before you can modify its configuration.

Related Topics

#  Adjusting the number of CPUs available to the Virtual Machine
= Adjusting the RAM available to the Virtual Machine

= Adjusting the NICs available to the Virtual Machine

= Converting two NICsinto a Bridge

# Allow Ports to Accept and Bridge Packets (Promiscuous Mode)

» Add Storage to the VMware Virtual Machine

0.20 Adjusting the number of CPUs available to the Virtual Machine

By default, all Virtual Appliances come configured with two virtual CPUs. Increase the number of CPUs to suit your
requirements.

NOTE
If the memory or hard disk space needs to be adjusted, please contact Exinda Support.

1. Open the VMware vSphere Client.

2. Right-click on the Exinda Virtual Appliance, and select Edit Settings.
3. On the Hardware tab, select CPUs.

4. Select the Number of virtual sockets.

5. Select the Number of cores per socket. The resulting total number of cores is a number equal to or less than the
number of logical CPUs on the host. For example, if the Number of virtual sockets is 2, and the Number of cores
per socket is 3, the total number of cores will be 6. Show Image..
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Hardware |D|:|1jgr|5 | Resowres | Virtual Machine Version: 8

™ show All Devices Add... | Remove | Mumber of virtual sockets: |2 vI
Hardware | summary | Mumber of cores per socket: |3 vI

Bl Memory 4008 MB

0 cPus 5 | Total number of cores: &

7] Video card Video card A ch - S | P

— ) . Changing the number of virtual CPUs after the guest
& VMCldevice Restricted 05 is installed might make your virtual machine

{ scsIcontrollerd L=I Logic Parallel unstable.

= Hard disk1 Wirtual Disk

% CD/DVD drive 1 CD-ROM 1 The virtual CPU configuration spedified on this page
BB Network adapter1 Master Virtual might violate the license of the guest O5.

B Network adapter2 jford-net1-LANI

& Floppy drive 1 Floppy 1
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6. Click OK.

0.21 Adjusting the RAM available to the Virtual Machine

By default, all Virtual Appliances come configured with 4GB of RAM. Increase the amount of RAM to suit your
requirements.

1. Open the VMware vSphere Client.

2. Right-click the Exinda Virtual Appliance, and select Edit Settings.
3. On the Hardware tab, select Memory.

4. Click OK.

5. Select the desired Memory Size
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0.22 Adjusting the NICs available to the Virtual Machine

By default, all Exinda Virtual Appliances come with four NICs. Of these, the first NIC is the Management Interface (for
managing the Virtual Appliance), the second NIC is the Auxiliary Interface (for HA topologies, clustering and out-of-path
deployments), while the remaining two ports are bundled as a bridge for inline deployments.

When placing the virtual appliance in line, you can add 2 extra NICs to be used as extra LAN and WAN ports for other
circuits. The additional NIC pairs are bridged by default. For more information, refer to Converting two NICs into a

Bridge (page 36)..

The following steps describe how to add extra NICs to the Virtual Appliance. You need to add extra NICs in pairs, in order
to create LAN/WAN bridges.

NOTE

Even though there is no limitation on the number of bridges a given Virtual Exinda appliance can have, the number
of connections can affect the performance of the VM. For more information, refer to Sizing and resource
requirements (page 9). Please ensure that the virtual hardware is appropriate to handle the number of expected
connections.

1. Open the VMware vSphere Client.

2. Right-click the Exinda Virtual Appliance, and select Properties.

3. Switch to the Hardware tab.

4. Click Add.

5. From the Device Type list, select Ethernet Adaptor and click Next.
6. In the Adapter Type list, select VMXNET 3.

7. Select the network to map the NIC to.
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Network Type
What type of network do you want to add?

IO .

Device Type —Adapter Type
MNetwork connection Type: YMEMET 3 il

Ready to Complete
Adapter choice can affect both networking performance and migration compatibility.
Consultthe VMware KnowledgeBase for mareinformation on choosing among the
network adapters supportedfor various guest operating systems and hosts.

—Metwork Connection
Metwork label:

fLan 1 |

Port: MfA

—Device Status

¥ Connect at pawer on

"*"_&J-'-—-J\'a‘-“r A g™

8. Click Next.

9. Review the information and click Finish to add the NIC.

10. Restart the virtual appliance. The new NICs are automatically detected and any additional NIC pairs are bridged.

0.23 Converting two NICs into a Bridge

Convert the first two NICs into a bridge so the Management Interface becomes a LAN Interface, and the Auxiliary
Interface becomes a WAN Interface.

Start the virtual appliance and then...

1. On your browser, open the ExindaWeb Ul (https://Exinda IP address).
2. Key-in the User and Password.

3. Click Login.

5. Navigate to Configuration > System > Network > IP Address.

6. To bridge the two NICs together, select the bridge number you would like to convert and click Apply Changes.

7. To manage the Virtual Appliance, in the IPv4 or IPv6 field specify an IP Address for the bridge.
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Network Setup

NICs IP Address Routes DNS HTTP Prosy Email SNMP Active Directory

Choose the mode of operation and enter IP Address and Netmask details for that mode. Also specify a Default Route.

Mote: Take care when making changes here as this appliance may become unreachable.

[ethO] [eth1] [Ethz] [eth3]
WAMN
Interface Settings
bro [
Role: ) Cluster [ Mirror [ | WCCP [ ] PER
Autocont: IPud: [ DHCP IPv6: [ SLAAC
ethi Dynamic Addresses: 10.10.6.53/16
fe80::20c:29ffe0c47ca/64
Static Addresses: | | / |
Comment: | |
Role: [ Clster [ ] Mirror [ | WCCP [ | PER
Autoconf: IPud: [[] DHCP IPvé: [ SLAAC
=t Static Addresses: | | / |
Comment: | |
Autoconi: IPvd: [ | DHCP IPvé: [ | SLAAC
by2 @ Dyn?mic Addresses: feB0:20c:29f fe0c47de/64
= Static Addresses: | |J.u |
Comment | |
Gateway Settings
IPyd: | |
IPys: |

Apply Changes

NOTE
For inline deployments to work correctly under VMware, the virtual switches need to allow promiscuous mode. For
more information, refer to Allow Ports to Accept and Bridge Packets (Promiscuous Mode) (page 37).

0.24 Allow Ports to Accept and Bridge Packets (Promiscuous Mode)

Any VMware virtual NIC used to deploy the virtual appliance in line must be configured to allow promiscuous mode,
ensuring the LAN and WAN ports are capable of accepting and bridging packets that are not destined for them.

1. Open the VMware vSphere Client.

2. Select the ESXi server, and switch to the Configuration tab.
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3.In the list of Hardware configuration options, select Networking.

4. Beside the switch name, click Properties.

5.In the switch properties, switch to the Security tab.

@ i s .

General Security |Trafﬁc Shaping I NIC Teaming I

—Puolicy Exceptions

Promiscuous Mode:
MAC Address Changes:
Forged Transmits:

= -

I.ﬁ.ccept

IA::cept

-]
-]

6. Set Promiscuous Mode to Accept.

7. Click OK.

8. Repeat these steps for each virtual switch that is attached to a NIC used in an inline deployment.

J’*f’dﬂﬂww'h

0.25 Add Storage to the VMware Virtual Machine

By default, all Exinda Virtual Appliances come with a single 50GB (fixed-size) disk. Usually, you will want more storage for
features such as WAN Memory and Edge Cache. This is achieved by adding an additional disk to the Virtual Appliance.

The size of the disk you should add largely depends on the amount of RAM allocated to the Virtual Appliance. As a

general rule, you should add a maximum of 100GB of disk storage per 1GB of RAM. So if you have given 4GB of RAM to

your Virtual Appliance, you can add up to 400GB of extra storage.

1. Open the VMware vSphere Client.

2. From the Hardware tab in the Exinda Virtual Appliance Properties screen, click Add.

3. Select Hard Disk, then click Next.
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Device Type

What sort of device do you wish to add to your virtual machine?

o

Device Type
Select a Disk
Create a Disk
Advanced Options
Ready to Complete

Choose the type of device you wish to add.

Serial Port
I Parallel Port

3 PCI Device (unavailable)
i Ethernet Adapter

§2 SCSI Device (unavailable)

— Information

This device can be added to this Virtual Machine.

Help |

= Back | Mext = I Cancel

4. Specify the size of the additional disk to create. This space will be added to the default 50GB that comes with the Vir-
tual Appliance. So if you add a 200GB disk here, the total storage for the Virtual Appliance will be 250GB.
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oS L )

Create a Disk
Spedfy the virtual disk size and provisioning policy

gleluic: TDm. i — Capadity

elect a Dis -

Create a Disk DiskSize: | 200-5 [eB -]
Advanced Options

Ready to Complete — Disk Provisioning

[T Allocate and commit space on demand (Thin Provisioning)

[~ Support dustering features such as Fault Tolerance

—Location

¥ Store with the virtual machine

" Specify a datastore:

I Browse... |

Help < Back | Mext = I Cancel

5. Click Next.

6. Attach the new disk to the next available SCSI node for best performance.
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Advanced Options

i N
ST L

These advanced options do not usually need to be changed.

Device Type

Select & Disk

Create a Disk
Advanced Options
Ready to Complete

Spedify the advanced options for this virtual disk. These options do not normally need
to be changed.

Virtual Device Node
& |scsIo:1)

|
~  |mE @0 ~]

—Mode
[T Independent
Independent disks are not affected by snapshots,
' Ppersistent

Changes are immediately and permanently written to the disk.

" Nonpersistent

Changes to this disk are discarded when you power off or revert to the
snapshot.

Help |

7. Click Next.

< Back | Mext = I Cancel

8. Review the information and click Finish to add the disk.

9. When the Virtual Appliance is next booted, you can use the storage commands in the CLI to provision the new stor-

age.The show storage command lists the current storage allocations as well as the Virtual Appliance's disks.

Services:

Disks:

Total: 36.22
Unallocated: 0

sdalO (internal) :
sdb: not in use - 214.7 GB

(config) # show storage

cifs: available - 3743.46M free of 3876M total
edge-cache: available - 3723.53M free of 3872M total
monitor: available - 9882.83M free of 10G total
users: available - 974.62M free of 1024M total
wan-memory: available - 17.21G free of 17.65G total

in use - 36.22 GB

10. The output shows that our new 200G disk is called 'sdb"and it's currently not in use. The storage disk add
command is used to provision the new disk.
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(config) # storage disk add sdb
This will erase all data on the disk. Do you really want to do this (Y/N)? [N] Y

11. After this command has executed, another look at show storage shows that the new disk is now in use and our
200G is ready for allocation.

(config) # show storage
Services:
cifs: available - 3743.46M free of 3876M total
edge-cache: available - 3723.53M free of 3872M total
monitor: available - 9882.83M free of 10G total
users: available - 974.62M free of 1024M total
wan-memory: available - 17.21G free of 17.65G total

Disks:
sdall (internal) : in use - 36.22 GB
sdb: in use - 200.00 GB

Total: 236.21G
Unallocated: 200G

0.26 Starting the VMware Virtual Appliance

When you are ready to start the virtual appliance for the first time, Power it on. The Virtual Appliance boots, and displays a
login prompt on the VMware console. At this point, you can login with the default username admin and password

exinda.

If the first NIC is connected to a network that provides addresses using DHCP, the Virtual Appliance should have picked
up an IP address. On the Virtual Appliance summary screen, VMware tools should display the IP address that the Virtual

Appliance has obtained.

Viware Tools; Unmanaged

IF Addresses: 192.168.0.221

DMS Mame; exinda-aah541
NOTE

The VMware Tools state 'Unmanaged' is normal. This simply means that VMware Tools are installed and running, but
are managed by the guest (the Exinda Virtual Appliance) rather than the host.

If the first NIC is not able to obtain an address using DHCP, you'll need to use the VMware console to enter the following
CLI commands to set a static IP address.

> en

# conf t
(config) # interface eth0 ip address <ip> <netmask>
(config) # ip default-gateway <default gateway>
(config) # ip name-server <dns server>

Once you have determined the IP address or set a static IP address, you can access the web-based user interface by
navigating to https//<ip address>.
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Related Topics

At this point, the following tasks should be completed before using the Virtual Appliance:

= Add extra NICs (if required) and deploy the Virtual Appliance either in line or out-of-path.
= Add and provision extra storage (if required).

= Obtain a license for this Virtual Appliance.

0.27 Install the Silicom Bypass Driver on ESXi 5.5 and 6.0

If your ESX/ESXi server has a Silicom network interface card (NIC), you must install the Silicom bypass driver.
1. Enable SSH on your ESX system.
a. Enable SSH through the CLI
i.Inthe /etc/ssh/sshd configmodify the following variable: PermitRootLogin yes
ii. Restart the sshd service: # service sshd restart
b. Enable local or remote TSM from the Direct Console User Interface (DCUI)
i. At the DCUI of the ESXi host, press F2 and provide credentials when prompted.
i. Scroll to Troubleshooting Options, and press Enter.

iii. If you want to enable local TSM, select Local Tech Support and press Enter once. This allows users
to login on the virtual console of the ESXi host.

iv. If you want to enable remote TSM, select Remote Tech Support (SSH) and press Enter once.
This allows users to login via SSH on the virtual console of the ESXi host.

RECOMMENDATION
Have your virtual Exinda already installed with the number of interfaces already set, keep it turned off, we will work
with it later.

2. Query the existing VIBs. Make sure you are in maintenance mode: # vim-cmd /hostsvc/maintenance
mode enter

NOTE
If the VIB you are deploying exist, you must first remove the existing VIB.

3. Run the following command to determine if any of the existing VIBs match the VIB you are deploying: # esxcli
software vib list | grep bpvm

NOTE
If there are no matches with your VIB, skip the next step.

4. If necessary, remove the existing VIB.
# esxcli software vib remove -n net-bpvm

# reboot
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4. Download the Silicom Driver for ESXi 5.1,5.5 and 6.0 from: https:.//up-
dates.exinda.com/exos/virtual/vmware/bypass/5.1-5.5-6.0/net-bpvm-2.0.1.15-TOEM.510.0.0.802205.x86_64.vib

5. Copy the driver into the ESX system with SCP or SFTP, drop it on the /tmp directory: # scp net-bpvm-
2.0.1.15-10EM.510.0.0.802205.x86_ 64.vib root@<esx-serverip>:/tmp

6. Deploy the VIB on the ESX system: # esxcli software vib install -v /tmp/net-bpvm-
2.0.1.15-10EM.510.0.0.802205.x86_64.vib --no-sig-check

NOTE
Ensure that you specify the full path tothe . vib file.

7.Reboot the appliance: # reboot

8. When the ESXI server comes back, verify that a new network adapter named “bpvm0” is listed under Configuration
> Network Adapters:

Resource Allocation ' Performance [alllMElb i Local Users & Groups ' Events | Permissions

Metwork Adapters

Device | Speed Configured Switch | MAC Address Observed IP ranges | Wake or

@ bpvmld 1000 Full 1000 Full vSwitchd 00:e0:ed:18:75:83  MNone Mo

Broadcom Corporation Broadcom NetXtreme I1 BCM5709 1000Base-T

B@ vmnic3 Down Negotiate vSwitch? 78:2b:ch:35:7b:2e  None Yes

EHR  umnir? inn Fall Manntiaba wiuitrhS TR 7h-rh* 35 ThIr KMnna Yo
NOTE

ge interfaces of the silicom card will now show up with the following duplex/speed settings if disconnected:

BR vmnic7 65535 Half Negotiate None 00:e0:ed:1e:85:15  None Yes
BB vmnicé 65535 Half Negotizte None 00:e0:ed:1e:85:14  None Yes

9. Create two standalone vSwitches, and assign the LAN interface of the bridge to one of them and the WAN interface
of the bridge to the other. (Configure both standalone switches with Promiscous Mode and as accepting all VLANs
(4065).

10. Look around in the Configuration > Networking configuration to see if the bvpm0 adapter is already attached to
a standalone vSwitch thatis not one of the ones created in the previous two steps. If that is the case, simply disconnect
that bvpmO adapter from it and assign it to the vSwitch that is currently connected to the LAN interface of the virtual
Exinda by using the following command: # esxcfg-vswitch -L bpvm0 vSwitch <NUMBER>

NOTE

[tis possible that the above command could fail saying that the bpvmO0 uplink already exists or that the device is
busy. If this happens, reboot the ESXi server one more time with the reboot command.

11. Connect the physical interfaces of the bridge to its peers (usually to the core switch and to the router/firewall).
12. Exit maintenance mode (You can right click the name of the ESXi server for this purpose).
13. Turn the Exinda ON

When the Exinda Appliancecomes back, you should see the bypass capability available and the duplex/speed
negotiations pointing to the right values. One vSwitch should have both the LAN interface of the bridge and the bpvm0O
driver while the other vSwitch will have the WAN interface of the bridge, refer to the below pictures (In the below
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example, the virtual exinda is configured with 4 interfaces, the first two are standalone interfaces while the last two are

for bridging purposes):

Regonl Tasks

= H eaan iocalhost Bl Viware ESX], 5.5.0, 2062150
B Exdnga - :

Getting Started | Summany | Wirtusl Machines | Resource Allecation | Performance ., [0 Led b it Lot Users B Groups. | Events | Permissions

Hardware Veew: VbR SRR S
Heal® Sisnug hgtworkieg
Prooessars
Mermory Standard Switch: wSeitchi Remne...  Frijested. .
St Wirked® Mt oot g Pyl il otin

* heteoring 2 VM Metwark & BB vt 130 Fell 02

Storage Adapters 1 virkoal rmaskingli]
Metwork Adapters Exindal o
Bidvareed Settings prepem—
Power Management B Mansgemant Nebwork .

: vkl s 10,0112

| Software T s bl e 2R Pt T
Limrgad Faatures
Teme Configanaton Standlard Switch wSwitchi Remeve... Preperes..
Uil anc Raing irtal Mt Poet Geup Foygarad it stars
Buthentcation Servies 2 an 3 [ P — o
Vit Machae St b Bhustcomes WLAN 1 AN (434 BB vesied 158 Full 3
Wl Musthire Smpo e Locaton
Sesurty Profle
Hogt Cache Configuraton Sanclard Switch; woaiich? Remoe. . Properbes.
Sriten Hesouror Alacation Wit Mgty B G Bl Aoy s
Agent Y Sethn o i B terfe—g B wreies 100 Full 2
At S A B 1 virtosl msgsisala] | WLAN 102 Al (43550

Eximdlad 5

[Tr— [ T Fiabalts

NOTE

Thdiatad e | Damsastad Sad T v | Gas Tima T Amlasad Tis

From ESXI v6.0, it is possible that after assigning the bpwvm0 driver to the “LAN" switch, the driver will not show up
as a Physical Adapter (unused) as in the above screenshot. if this is the case, you can continue”
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0.28 Monitor IOPS in VMware vSphere

IOPS (Input/output Operations per Second; pronounced "eye-ops") is a common performance measurement used to
benchmark computer storage devices like hard disk drives (HDD), solid state drives (SSD), and storage area networks
(SAN). As with any benchmark, IOPS numbers published by storage device manufacturers do not guarantee real-world
application performance. IOPS are measured in both Commands per Second (IO operations per second) or Throughput
(Megabytes per Second).
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In the sizing charts for the Exinda virtual appliance (EXN-V) we have represented the measurement in Commands per
Second. There are three numbers for IOPS:

= ECIOPS for Edge Cache IOPS

= Monitoring IOPS

= Average IOPS for Optimization IOPS

The formula to calculate the IOPS for EXN-V you will add the IOPS for each service:

Edge Cache IOPS + Monitoring IOPS + Average Optimization IOPS = Total IOPS

Example: Virtual Model - 2061 IOPS

Edge Cache IOPS 30

Monitoring IOPS 140
Average Optimization IOPS 200
Total IOPS 370

1. On the Custom Performance Chart for the EXN-V, select Virtual disk > Real-time.

Branch \ / Data Center \
BR Services APP APP @I
Exinda Exinda
M VM
0s [ 0os

e IR =
=
/o /

2. Select Average write requests per second (inbound and outbound). The report indicates the Minimum, Max-
imum, and Average Commands per Second.

=N
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Running on Citrix XenServer

Learn how to deploy Exinda Virtual Appliance as well as customize the virtual hardware to suit your requirements. Exinda
Virtual Appliances are available for Citrix XenServer hypervisors.

NOTE
The Exinda Virtual Appliance must be run on either Citrix XenServer 6.2 or 6.5.

0.29 Installing the Virtual Appliance on XenServer

1. Liaise with your local Exinda representative to obtain the download files.
2. Download the Virtual Appliance XVAfile.

3. Open your Citrix XenCenter client and select File > Import...

4. Select the Virtual Appliance XVA file, and click Next.

5. Select the target XenServer to deploy the Virtual Appliance, and click Next.

6. Choose the storage location for the Virtual Appliance. By default, the Virtual Appliance comes with a single, 50GB disk.
Additional storage can be added in the form of another disk after the Virtual Appliance has been deployed. For more
information, refer to Add storage to the XenServer virtual appliance (page 54). Then click Next.

7. Choose the NIC mapping. By default, the Virtual Appliance comes with 4 NICs. The first NIC is the Management Inter-
face, and you should connect it to a network that allows you to manage the Virtual Appliance. The second NIC is an AUX
Interface, and is usually used for clustering, high availability or out-of-path deployments. This interface can be left dis-
connected if not required. In order to fully deploy the Virtual Appliance in line, you may need the additional NICs bey-

ond the four in the configuration. For more information, refer to Additional NICs (page 51). Then click Next.

8. Review the information and clear the 'Start VM(s) after import' box if you want to add extra NICs or storage, and click
Finish to deploy the Virtual Appliance.

9. Select the Exinda virtual machine you are importing, and switch to the Log tab to see the progress and the com-
pletion notification.

TIP

[tis highly recommend that you import the virtual machine on a Gigabit network connection or local storage, as the
import file is large in size and installation is affected by slowly performing networks.

10. Right-click on the imported Exinda and select Start the Exinda virtual appliance. You will see the progress bar
screen below in the Log tab indicating you have successfully started the virtual appliance.

11. On the XenCenter Console tab of the Exinda virtual machine, type the credentials and the default parameters as
part of the first time wizard setup. The default user name is admin, and the password is exinda.

12. Press Enter to read the EULA agreement. Press Ctrl-C to get to the EULA agreement question.

13. Press Y to accept the EULA agreement and press Enter.
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14. You will be prompted with a series of questions as part of the initial configuration Wizard. It is recommended you

accept the defaults, as you have the option to configure the system later from the Exinda GUI. Press Yes. Use the fol-
lowing defaults to complete the wizard configuration.

s Select No todisable IPve.
s Select Yes to configure ETHO for management access. This will disable the BRO bridge.
s Select Yes to use DHCP on ETHO.
» Select null to default to the Exinda hostname.
» Select null for SMTP server address.
s Select null for email address for reports and alerts.
= Select null to use the default password which is “exinda”.
s Select Yes to change the interface speed.
s Select AUTO to configure the interface speed on ETHO (assumes a gigabit NIC).
You have successfully completed the wizard setup.

15. Determine the IP address of your Exinda virtual appliance on the XenServer Network tab of the Exinda virtual
machine and note the IP address assigned by default to NIC 0.

16. Browse to the Dashboard tab and find the Host-ID that the XenServer host created for this virtual machine.

Related Topics

Once the appliance is deployed, review the following sections:
= Custom Settings

= Additional NICs

#» Add storage to the XenServer virtual appliance

0.30 Modifying the XenServer Virtual Machine Configuration

To improve the performance of the virtual appliance, change the number of CPUs, the RAM, networking, and storage
allocated to the virtual machine.

TIP
You will need to shut the virtual appliance down before you can modify its configuration.

Related Topics
= Custom Settings
= Additional NICs

» Add storage to the XenServer virtual appliance

0.31 Custom Settings

By default, all Exinda virtual appliances come with four network interface cards (NICs):
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TIP
Before you can make changes to the virtual appliance, you will need to shut it down.

brz
[eth0]  [ethl] [eth2] [eth3]
LAN WAMN
Interface Settings
brid ]
Raola: | | Cluster | | Mirror | | WCCP | | PBR
Autocont: IPvd: [ DHCP IPv&: | | SLAAC
ethD Dynamic Addresses: 10.10.1.17916
feB0:20c:29ff-fef2:4d11/64
Static Addresses: | | / |
Comment: | |
Role: | | Cluster [ | Mirror [ | WCCP [ | PER
Autocont: IPvd: [ | DHCP IPvé: || SLAAC
ethi
Static Addresses: | | / |
Comment: | |
Autocont: IPvd: [ | DHCP IPvé&: | | SLAAC
br2 [ Static Addresses: | |J.'|
Comment: | |
Gateway Settings
Py | |
IPvé: |

Apply Changes

If more interfaces are needed, please follow the next procedure (the Exinda appliance will recognize that if two NICs are
added they can then be bridged). The following steps describe how to add extra NICs to the Virtual Appliance. In order
to create LAN/WAN bridges, you need to add extra NICs in pairs, .

1. From the Networking tab in the Exinda Virtual Appliance settings, click Add Interface.

2. Choose the network to which to map this new NIC, then click Add.

0.32 Additional NICs

By default, all Exinda Virtual Appliances come with four NICs. The first NIC is the Management Interface (for managing
the Virtual Appliance) and the second NIC is the Auxiliary Interface (for use with HA, clustering, and out-of-path
deployments).

There are 2 options when it comes to placing the Virtual Appliance in line:

Exinda Network Orchestrator | 51



= Convert the first two NICs into a bridge, so that the Management Interface becomes a LAN Interface and the Aux-
iliary Interface becomes a WAN Interface. This is achieved by booting into the Virtual Appliance and navigating to the
Configuration > System > Network > IP Address page on the Web Ul, advanced mode. From this page, you can

select the br0 checkbox to bridge the first two NICs together. In order to manage the Virtual Appliance, an IP Address
must be specified for this bridge. Stay cautious when using this option as this will cause the first two NICs to be bridged.

Network Setup
NICs IP Address Routes | DNS HTTP Proxy Email | SNMP § Active Directory
Choose the mode of operation and enter IP Address and Metmask details for that mode. Also specify a Default Route.
Mote: Take care when making changes here as this appliance may become unreachable.
br2
[eth0] [eth] [eth2] [eth3]
LAMN WAN
Interface Settings
brd |
Role: ) Clster [ Mirror [ ] WCCP [ PER
Autoconf: IPud: [ DHCP IPvé: [ SLAAC
thi Dynamic Addresses: 10.10.6.53/16
feB0:20c:29ff fe0c47ca/64
Static Addresses: | | J |
Comment: | |
Role: [] Cluster [ ] Mirror [] WCCP ] PSR
Autocont: IPvd: [|] DHCP IPvé: [] SLAAC
ethi
Static Addresses: | | / |
Comment | |
Autocont IPvd: [ | DHCP IPvé: || SLAAC
Dynamic Addresses: feB0:20c:29f fe0c47de/64
br2 ¥ Static Addreszes: | |Ja |
Comment: | |
Gateway Settings
IPyd: | |
IPys: |
Apply Changes

IMPORTANT
You must power off the virtual appliance while changing the virtual machine configuration.

= Use the 2 extra NICs as LAN and WAN ports. These 2 additional NICs can be bridged to allow the Virtual Appliance to
be placed in line.
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The following steps describe how to add extra NICs to the Virtual Appliance. You need to add extra NICs in pairs, in order
to create LAN/WAN bridges.

1. From the Networking tab in the Exinda Virtual Appliance settings, click Add Interface.

2. Choose the network to map this new NIC to, then click Add.

© Add Virtual Interface [N (oS

Select your network and MAC address for this virtual interface.
You can also optionally define a QoS limit.

Metwork: | Metwark 2 i

MAC address:

@ Auto-generate a MAC address

7 Usethis MAC address:  aa:bbiccidd:eaff

Qob settings:
[] Enable a QoS limit of: Khbytes/s

3. Take care when using this option as this will cause the first two NICs to be bridged.

4. When the Virtual Appliance is next booted, the new NICs will be automatically detected and any additional NIC pairs

will be bridged. Below is what the System -> Network -> IP Address page on the Web Ul looks like after 2 extra
NICs have been added.
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brz

[ethD] [eth1l] [eth2] [eth3]

LAM WAN
Interface Settings

bro [
Role: [ Cluster [T] Mirror [] WCCP
Sutoconf: IPv4: DHCP IPve: [| SLAAC

h Dynamic Addresses: 192,168.0.225/24

Sl fe80::10e0: 9ff:fecd: 3021/64
Static Addresses: | | / |
Comment: | |
Role: [ Cluster [ Mirror [] WCCP
Autoconf: IPv4: [| DHCP IPvE: [ SLAAC

ethi Dynamic Addresses: fed0::4430:b2ff:fe2a:c4a5/64
Static Addresses: | | / |
Comment: | |
Sutoconf: IPv4: [| DHCP IPvE: [| SLAAC
Dynamic Addresses: fe80::2c5d: 7fff:fed4:9221/64

br2 Static Addresses: | | / |
Comment: | |

Gateway Settings
IPv4: | |
IPVE: |

| Apply Changes |

0.33 Add storage to the XenServer virtual appliance

By default, all Exinda Virtual Appliances come with a single 50GB (fixed-size) disk. Usually, you will want more storage for
features such as WAN Memory and Edge Cache. This is achieved by adding an additional disk to the Virtual Appliance.

The size of the disk you should add largely depends on the amount of RAM allocated to the Virtual Appliance. As a
general rule, you should add a maximum of 100GB of disk storage per 1GB of RAM. So if you have given 4GB of RAM to
your Virtual Appliance, you can add up to 400GB of extra storage.

IMPORTANT
You must power off the virtual appliance while changing the virtual machine configuration.

1. From the Storage tab in the Exinda Virtual Appliance settings, click Add.
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|
TN W

Enter a name, description and size for your virtual disk. The size of your disk and the home server setting
of any VM the disk belongs to will affect which storage locations are available.

Mame: Exinda Extra Disk

Description:  Eyinda Extra Disk

Size: | 2001 [GB |

Location: Local storage on xenserver-server EERel R iRl

| Add || Cancel

2. Specify the size of the additional disk to create. This space will be added to the default 50GB that comes with the Vir-
tual Appliance. So if you add a 200GB disk here, the total storage for the Virtual Appliance will be 250GB.

3. Then click Add. The Virtual Appliance storage should look something like this:

Position Name Description SR Size | Read Only | Priority Active Device Path

Exinda Base Disk Exinda Base Disk Local storage on xenserver-server 50 GE No 0 (Highest] Mo <unknown>

1 Exinda Extra Disk Exinda Extra Disk Local storage on xenserver-server 200 GB No 0 (Highest] Mo <unknown:

4. When the Virtual Appliance is next booted, you can use the storage commands in the CLI to provision the new stor-
age.The show storage command lists the current storage allocations as well as the Virtual Appliance's disks.

(config) # show storage

Services:

cifs: available - 3743.46M free of 3876M total
edge-cache: available - 3723.53M free of 3872M total
monitor: available - 9882.83M free of 10G total
users: available - 974.62M free of 1024M total
wan-memory: available - 17.21G free of 17.65G total

Disks:
xvdalO (internal) : in use - 36.22 GB
xvdb: not in use - 214.7 GB

Total: 36.22
Unallocated: 0

5. The output shows that our new 200G disk is called 'xvdb'and it's currently notin use. The storage disk add
command is used to provision the new disk.
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(config) # storage disk add xvdb
This will erase all data on the disk. Do you really want to do this (Y/N)? [N] Y

6. After this command has executed, another look at show storage shows that the new disk is now in use and our
200G is ready for allocation.

(config) # show storage

Services:

cifs: available - 3743.46M free of 3876M total
edge-cache: available - 3723.53M free of 3872M total
monitor: available - 9882.83M free of 10G total
users: available - 974.62M free of 1024M total
wan-memory: available - 17.21G free of 17.65G total

Disks:
xvdalO (internal) : in use - 36.22 GB
xvdb: in use - 200.00 GB

Total: 236.21G
Unallocated: 200G

For more information on adding disks in general and allocating storage, see Configuring Storage.

0.34 Starting the XenServer Virtual Appliance

When you are ready to boot the Virtual Appliance for the first time, Power it on. The Virtual Appliance will boot, and
when ready, will display a login prompt on the XenCenter console.

At this point, you can login with the default username admin and password Exinda.

If the first NIC is connected to a network that provides addresses using DHCP, the Virtual Appliance should have picked
up an IP address. On the Virtual Appliance Networking screen, XenCenter should display the IP address that the Virtual
Appliance has obtained.

Metworks
Device «~ MAC Limit Metwaork IP Address Active

12:e0:09:cd:30:21 Metwork 0 1921680225  ‘Yes
ot 46:30:b2:2a:cd:ad Metwork 1 Unknown Yes

If the first NIC is not able to obtain an address using DHCP, you'll need to use the XenCenter console to enter the
following CLI commands to set a static IP address.

> en

# con t
(config) # interface eth0 ip address <ip> <netmask>
(config) # ip default-gateway <default gateway>
(config) # ip name-server <dns server>

Once you have determined the IP address or set a static IP address, you can access the web-based user interface by
navigating to https;//<ip address>.
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Related Topics

At this point, the following tasks should be completed before using the Virtual Appliance:
= QObtain alicense for this Virtual Appliance.

= Add and provision extra storage (if required).

= Add extra NICs (if required) and deploy the Virtual Appliance either in line or out-of-path.
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Running on Microsoft Hyper-V

The following sections describe how to deploy Exinda Virtual Appliance as well as to customize the virtual hardware to
suit your requirements.

The Exinda Virtual Appliance are available for Microsoft Hyper-V hypervisors.

0.35 Install the Virtual Machine on Hyper-V

The Exinda Virtual Appliances have been prepared to run in a variety of virtual environments. Hyper-V provides support
for hosting the Exinda Virtual Appliances in Microsoft Server 2012 and 2012 R2.

1. Liaise with your local Exinda representative to obtain the download files.
2. Unzip the ZIP file into a local folder. The ZIP archive contains three folders, which contain the following:
s Snapshots — this folder is empty.
s Virtual Hard Disks — contains the virtual machine file in VHDX format.
s Virtual Machines — contains an XML file that in turn contains the configuration of the virtual machine.

3. Open the Hyper-V Manager.

4. In the left pane, right-click on the host machine and select Import Virtual Machine. The "Import Virtual Machine"
wizard opens.
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Action  View

Help

Hyper-V Manager

@z e B

23 Hyper-V Manager
§a HYPERV-2012-B

Ei HYPERV-2p12-B2

Virtual Machines

Mew

»

Import Virtual Machine...

Hyper-V Settings...
Virtual Switch Manager...
Virtual SAN Manager...

State CPU Usage Assigned Memory

No vitual machines were found on this server.

New

Import Yirtual Machine...
Hyper-V Settings...
Virtual Switch Manager...
Virtual SAN Manager...

| HYPERV-2012R2 -

»

Edit Disk...

Edit Disk...

Inspect Disk...

Inspect Disk...

Stop Service Stop Service

Remove Server
Refresh

Remowe Server

Refresh

No virtual machine selected.

PX@ORBR RIBmEE

W View

Help

=l

Help

Mo item selected.

Displays the Import Wizard.

5. Click the Browse button and navigate to and select the local folder where you unzipped the downloaded file. The
wizard then recognizes the virtual machine.
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EE] Hyper-V Manager =2 1C1] X
File Action View Help
[l
@ B o : :
| Import Virtual Machine 28
23 Hyper-V Ma
5 HYPERVA Select Folder n . N
S HYPERVA ||
't) - 1 | L« Cov export e v 0| | Search export R | »
Organize = 2. @ irtual Machine..,
Settings...
& Microsoft Manageme Y exinda-v7.4.1-4043-x86_64 @ Witch Manager...
€l Metwork 12/21/2015 12:12 PM AN Manager
1M hyperv-2012-r2. exanet
isk...
vice
Server
4
Folder: | exinda-v7.4.1-4048-x36_64 |
Select Folder | | Cancel Cancel

6. On the Import Virtual Machine dialog box, click Next. The "Choose Import Type" page of the wizard opens.

7. Select the Copy the virtual machine... radio button. The "Choose Folder for Virtual Machine Files" page of the wiz-

ard opens.

8. If you prefer not to use the default folders, select the Store the virtual machine... checkbox and for each of the
three folder options browse to and select your preferred folder.
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Hyper-V Manager

File Action View Help

Before You Begin
Locate Folder

Select Virtual Machine
Choose Import Type
Choose Destination
Choose Storage Folders

Summary

Choose Folders for Virtual Machine Files

‘You can spedfy new or existing folders to store the virtual machine files. Otherwise, the wizard
imports the files to default Hyper-V folders on this computer, or to folders specified in the virtual
machine configuration.

[+ Store the virtual machine in a different location

Virtual machine configuration folder:

|C Y\ProgramDataMicrosoft\Windows\Hyper-v | | Browse. ..

Checkpoint store:

|C Y\ProgramDataMicrosoft\Windows\Hyper-v | | Browse. ..

Smart Paging folder:

|C Y\ProgramDataMicrosoft\Windows\Hyper-v | | Browse. ..

m [ [>]

9. Click Next. The "Choose Folders to Store Virtual Disks" page of the wizard opens.

10. Click the Browse button and select the folder to use.
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EE] Hyper-V Manager =2 1C1] X
File Action View Help

[
e FHFEa , :
| Import Virtual Machine “
23 Hyper-V Ma
53 HYPERV- h12-R2 s
g HYPERVA ﬁ Choose Folders to Store Virtual Hard Disks S
irtual Machine...
Before You Begin Where do you want to store the imported virtual hard disks for this virtual machine? Settings...
Locate Folder Location: | | Browse... pitch Manager...
Select Virtual Machine BN Manager.
Choose Import Type
Choose Destination
isk...
Wice
Summary
Server
»
< Previous | | Mext = | | Finish | | Cancel
< m [ [»]

11. Click Next. The "Completing Impoprt Wizard" page opens.
12. Review the settings in the right pane. If they are correct, click Finish. The installation proceeds.

When the installation is complete, an entry for the new virtual machine appears in the Virtual Machines pane in the
Hyper-V Manager.
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EE] Hyper-V Manager =2 = -
File Action View Help
ez
23 Hyper-V Manager Actions
HYPERV-2012-B Virtual Machines
E el HYPERV-2012-R2 N
=E| MName “ State CPU Usage Assigned Memory Uptime New »
g exinda-v7.4.1-4048x86_64  OF
E—E:'> Import Yirtual Machine..,
| Hyper-V Settings...
E’r,_: Virtual Switch Manager...
al Virtual SAN Manager...
<] m @A Edit Disk...
. E‘ Inspect Disk...
Checkpoints i
(®) Stop Service
Na virtual machine selected. 75 Remove Server
i Refresh
View »
Help
Details
No ftem selected.
< n [ [>]

The Virtual Machine, as supplied by Exinda, may not have all of the configuration options you prefer. For example, the
disk storage is confined to 50GB, which is unlikely to be sufficient for your needs. When preparing the Exinda Virtual
Appliance for download, it is not possible to know just what hardware is available on the host machine. After you have
installed the virtual machine, you will need to make some adjustments to the configuration using the controls in the
Hyper-V Manager. See the following related tasks.

IMPORTANT

Before powering on your Exinda Virtual Appliance for the first time, you need to make sure that the virtual
configuration is what you need. See the following Related Tasks to fully configure your VM.

Related Topics

B

+ Adjusting the number of CPUs available to the Virtual Machine

e

» Adjusting the RAM available to the Virtual Machine

e

+ Adjusting the NICs available to the Virtual Machine

# Increasing the size of the virtual hard drive
0.36 Modifying the Hyper-V Virtual Machine Configuration

As supplied, the Exinda Virtual Appliances will require some configuration changes before you introduce them to your
network. For example, the virtual hard drives are limited to 50GB, which would be unlikely to be sufficient for your needs.
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The virtual machines available are sized with minimal configuration as it is not possible to know just what hardware is
available on any host machine. To edit the configuration, you need to open the settings for the virtual machine in the
Hyper-V Manager.

There are many settings that you can change, but for the purposes of configuring the Exinda Virtual Appliance, these
task instructions are limited to what is necessary for bringing the appliance into an operational state. If you need more
information, please consult the documentation for Hyper-V. This topic deals with changes to the configuration related to
the number of CPUs, the available RAM, the NICs, and adjusting the storage for the virtual machine.

The configuration changes are required before your initial use of the virtual machine. You can also make further changes
to your virtual machine at any later time. If over time you require more resources for the virtual machine, as long as those
resources are available on the host, you can make them available to the guest.

NOTE
You will need to shut the virtual appliance down before you can modify its configuration.

Related Topics

e

+ Adjusting the number of CPUs available to the Virtual Machine

B

» Adjusting the RAM available to the Virtual Machine

e

» Adjusting the NICs available to the Virtual Machine

= |ncrease storage by adding new virtual drives

0.37 Adjusting the number of CPUs available to the Virtual Machine

After installing the virtual machine, you may need to adjust the number of CPUs that are available to the Exinda Virtual
Appliance. The basic virtual machine configuration includes a minimal number of CPUs, but if you have spare CPUs on
the host machine, you may want to make these available to the virtual machine. You make adjustments to the number of
CPUs in the Hyper-V Manager.

1. Open the Hyper-V Manager.

2. In the left pane, right-click on the virtual machine you need to edit and select Settings. The Settings dialog box for
the virtual machine opens.

3. In the left pane, under Hardware, select the Processor item. The processor settings open in the right pane.
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) Settings for exinda-v7.4.1-4048-x86_64 on HYPERV-2012-R2 \;|£“

| exinda-v7.4.1-4048-x86_64 v 4 b Q@ |
# Hardware |~ | [} Processor
'{ﬂ Add Hardware
1K BIOS You can |_'nndiﬁ-' the number of virtual Processors bazed on the number _nf Processors an
Boot from €D the physical computer. You can also modify other resource control settings.
[ Memary Mumber of virtual processors: '
4056 MB
| Processor Resource control
2 Virtual processors You can use resource controls to balance resources among virtual machines.

= Ei IDE Controller 0
—w Hard Drive

Vfirtual machine reserve (percentage):

exinda-v7. 4. 1-4043-x36_6... Percent of total system resources:
&4 DVD Drive
exinda-v 7.4, 1-4048-x86_5... Virtual machine limit {(percentage):

= [Ei IDE Controller 1
&4 DVD Drive
Mone
&£l SCSI Controller
[E] Management
Mot connected
0 Extra
Mot connected
O Lan
Mot connected
O wan
Mot connected

T com 1

exinda-353hac2c-310e-452d-4. ..

2 com 2

More

I Diskette Drive
Mone

Percent of total system resources: il

] slls] - L)

Relative weight:

# Management

MName

exinda-v7. 4. 1-4048-x86_o4 o |

| 0K | | Cancel | | Apply

4. In the Number of virtual processors spinbox, click the up- or down-arrows to adjust the number of CPUs.

NOTE

In this pane you can also adjust several other settings to balance resources among any other virtual machines.
Consult the Hyper-V documentation for more information on these settings.

5. Click OK. The number of CPUs available to the virtual machine is immediately adjusted.

NOTE

These instructions also apply to changing the configuration after the virtual appliance has entered service.

Related Topics

# Adjusting the RAM available to the Virtual Machine

# Adjusting the NICs available to the Virtual Machine
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# Increasing the size of the virtual hard drive

0.38 Adjusting the RAM available to the Virtual Machine

After installing the virtual machine, you may need to adjust the amount of RAM that is available to the Exinda Virtual
Appliance. There is a basic amount of RAM provided in the Exinda Virtual Appliance, but if you have spare RAM on the
host machine, you may want to make this available to the virtual machine. You make adjustments to the amount of RAM
in the Hyper-V Manager.

1. Open the Hyper-V Manager.

2. In the left pane, right-click on the virtual machine you need to edit and select Settings. The Settings dialog box for
the virtual machine opens.

3.In the left pane, under Hardware, select the Memory item. The memory settings open in the right pane.

=] Settings for exinda-v7.4.1-4048-x86_64 on HYPERV-2012-R2 BEEIE)
| exinda-v7.4.1-4048-x86_64 vl 4 b |Q |
# Hardware |i| @ Memory
'%ﬂ Add Hardware
1 BIOS You can configure options for assigning and managing memory for this virtual machine.
Boot from CD Spedfy the amount of memory that this virtual machine will be started with.

Startup RAM: 4095 MB
A p | 03]

ﬁ Processor

Dynamic Memary
2 Virtual processors

= You can manage the amount of memory assigned to this virtual machine
= Eif IDE Controller 0 dynamically within the spedfied range.
= Hard Drive
exinda-v 7.4, 1-4048-x86_5...

&% DVD Drive - . -

ws Minimum RLAM: 212| MB
exinda-7.4. 1-9043-%36_6... 8 | 52

= EiE IDE Controller 1 Maximum FAM: 1043576 MB

&4 DVD Drive
Mone Specify the percentage of memory that Hyper-¥ should try to reserve as a buffer.
Hyper-V uses the percentage and the current demand for memory to determine an
& 5C5I Controller amount of memary for the buffer,
[ Management

Mot connected Memory buffer: 0 %
O Extra

Mot connected
O Lan

Mot connected
O wan

Mot connected Low C . High

2 com 1 L

exinda-953b6c2c-310e-43ed-9... @I Spedfying a lower setting for this virtual machine might prevent it from
@r coM 2 starting when other virtual machines are running and available memory is low.

[] Enable Dynamic Memory

Mermory weight

Spedfy how to prioritize the availability of memory for this virtual machine
compared to other virtual machines on this computer.

Mone

I Diskette Drive
Mone

% HManagement

Mame

exinda-v7. 4, 1-4048-x36_54 w

| 0K | | Cancel | | Apply

4. In the Startup RAM field, type a new amount for the quantity of RAM.
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TIP

In this pane you can also Enable Dynamic Memory and specify amounts, and adjust Memory weight. Consult the
Hyper-V documentation for more information on these settings.

5. Click OK. The amount of RAM available to the virtual machine is immediately adjusted.

NOTE
These instructions also apply to changing the configuration after the virtual appliance has entered service.

Related Topics
#  Adjusting the number of CPUs available to the Virtual Machine
= Adjusting the NICs available to the Virtual Machine

# Increasing the size of the virtual hard drive

0.39 Adjusting the NICs available to the Virtual Machine

After installing the virtual machine, you will need to enable the NICs that are available to the Exinda Virtual Appliance.
The basic virtual machine configuration does not include the configuration necessary to link the virtual devices to the
physical hardware on the host machine. You make adjustments to the number of CPUs in the Hyper-V Manager.

1. Open the Hyper-V Manager.

2. In the left pane, right-click on the virtual machine you need to edit and select Settings. The Settings dialog box for
the virtual machine opens.

3. In the left pane, under Hardware, select the network adapter to update. The network adapter settings open in the
right pane.

4. In the Virtual switch drop-down list, select the network to which to map the NIC.

TIP

In this pane you can also enable Bandwidth Management. Consult the Hyper-V documentation for more
information on these settings.

5. Click OK. The NIC configuration is immediately modified for when the virtual machine is started.

NOTE
These instructions also apply to changing the configuration after the virtual appliance has entered service.

Related Topics

= Adjusting the number of CPUs available to the Virtual Machine

0.40 Increase storage by adding new virtual drives

During the process of installing the virtual machine, you needed to connect the virtual hard drive (VHD) to the Exinda
Virtual Appliance. Prior to powering the VM on for the first time, it is likely that you should need to increase the size of the
VHD. You can also make this adjustment after bringing the Exinda Virtual Appliance into service. You make adjustments
to the size of the VHD in the Hyper-V Manager by adding additional hard drives to the VM.
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0.40.1 Prerequisites

Before starting this task, ensure that the virtual machine is switched off.

0.40.2 Procedure
1. Open the Hyper-V Manager.

2. In the left pane, right-click on the virtual machine you need to edit and select Settings. The Settings dialog box for

the virtual machine opens.

3. In the left pane, under Hardware, select any IDE Controller item. The Hard Drive settings open in the right pane.

4. Select the Hard Drive option in the right panel and click Add.

“ﬂﬂ Add Hardware
1 BIOS
Boot from CD
[T Memory
4095 MB
ﬁ Processor
2 Virtual processors
B [EiE IDE Contraller 0
—w Hard Drive
exinda-v7. 4. 2-4118-x86_6...
&4 DVD Drive
exinda-v7. 4. 2-4118-x36_67...
&% DVD Drive
Mone
®E: SCSI Controller
LE.I] Management
Mot connected
LE.I] Extra
Mot connected
O Lan
Mot connected
0 wan
Mot connected

= com1

exinda-9eafa18b-12ac-4547-3. ..

= comz

Mone

I Diskette Drive
Maone

(&3]

(&3]

(&3]

% Management

Mame

exinda-v7. 4. 2-4113-x86_564

W

é_?j Settings for exinda-v7.4.2-41158-x86_64 on HYPERV-2012-R2 - X
| exinda-v7.4.2-4113-x86_64 v 4 b |G
# Hardware ”

Eif IDE Controller

You can add hard drives and CD/DVD drives to your IDE controller.
Select the type of drive you want to attach to the controller and then dick Add.

Hard Orive
DVD Drive

You can configure a hard drive to use a virtual hard disk or a physical hard disk after
you attach the drive to the controller.

I oK I | Cancel | Apply

5. In the Hard Drive section, select “IDE Controller 1" as the Controller and “1 (in use)” as the location. By default, this is
the only slot available in the virtual machine to which toinsert a new Virtual Hard Drive. However, if more hard drives are
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needed in the future, you could remove the DVD Drives present by default given that these are not needed in the appli-
ance. In such a case, Controller O: Location 1 and Controller 1: Location 0 will also be available for further use.

2% Settings for exinda-v7.4.2-4118-x86_64 on HYPERV-2012-R2 —

= Ei} IDE Controller 0
® = Hard Drive
£ DV Drive
= IDE Controller 1
&% DVD Drive
MNone
® = Hard Drive
<file>
&3] SCSI Controller
® [ Management
Mot connected
@ Extra
Mot connected
U Lan
Mot connected
® 0 wan
Mot connected
T coM1
exinda-GeffE 18b-12ac-4547-8. ..
T comz2
Mone
{d Diskette Drive

Mane

# Management

exinda-v7.4.2-4118-x36_&...

exinda-v7.4.2-4118-x86_4...

You can compact, convert, expand, merge, reconnect or shrink a virtual hard disk
by editing the assodated file. Spedfy the ful path to the file.

(® virtual hard disk:
| |

Browse...

Inspect
Physical hard disk:

Mt

@I If the physical hard disk you want to use is not listed, make sure that the

disk is offline. Use Disk Management on the physical computer to manage
physical hard disks.

To remove the virtual hard disk, dick Remove. This disconnects the disk but does not

delete the assodated file.
| Remove |

>
| exinda-v7.4.2-4118-x86_64 v 4 b Q@
# Hardware J\ = Hard Drive
1 Add Hardware
K BIOS You can change how this virtual hard disk is attached to the virtual machine, If an
b= Boot from CD operating system is installed on this disk, changing the attachment might prevent the
s virtual machine from starting.
b hf;?;rs Controller: Location:
EBP - IDE Controller 1 w~ |1[‘muse] ~
2 Virtual processors Media

Cancel |

Apply

6. Click New. The New Virtual Hard Disk wizard opens.

Exinda Network Orchestrator

| 69




iy Mew Virtual Hard Disk Wizard %

‘-..I'. :ll-

CJ:!:P Choose Disk Format

Before You Begin What format do you want to use for the virtual hard disk?
O wo
Choose Disk Type Supports virtual hard disks up to 2,040 G8 in size,
Specify Mame and Location @) VHDX
Configure Disk This format supports virtual disks up to 64 T8 and is resilient to consistency issues that might occur

Summary from power falures. This format is not supported in operating systems earlier than Windows 3.

< Previous Mext = || Finish || Cancel

7. Select VHDX as the Disk Format type and click Next.
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i New Virtual Hard Disk Wizard

W Choose Disk Type

Before You Begin

Choose Disk Format
Specify Mame and Location
Configure Disk

Summary

What type of virtual hard disk do you want to create?

(®) Fixed size

This type of disk provides better performance and is recommended for servers running applications
with high levels of disk activity, The virtual hard disk file that is created initially uses the size of the
virtual hard disk and does not change when data is deleted or added.

() Dynamically expanding

This type of disk provides better use of physical storage space and is recommended for servers
running applications that are not disk intensive, The virtual hard disk file that is created is small
initially and changes as data is added.

() Differencing
This type of disk is associated in a parent-child relationship with another disk that you want to
leave intact. You can make changes to the data or operating system without affecting the parent

disk, so that you can revert the changes easily. All children must have the same virtual hard disk
format as the parent (VHD or YHDX).

< Previous | | Mext = Finish Cancel

8. In the Choose Disk Type section, select the Fixed Size option and click Next.
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45 Mew Virtual Hard Disk Wizard x

A

W Specify Name and Location

Before You Bagin Specify the name and location of the virtual hard disk file,
Choose Disk Format

Mame: IEﬂ'ﬂaNm-Drjveluhdx |

Choose Disk Type
Location: |C:1I.Isers‘Puh1lc‘ﬂncuments\,l-|yper-U\‘u'i’hjal Hard Disks', | Browse...
Configure Disk

sSummary

< Previous Next> | | Finish Cancel

9. Specify a Name and Location for the virtual hard drive, and click Next.
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i MNew Virtual Hard Disk Wizard x

A

e

.C‘;_i?i) Configure Disk

Before You Bagn You can create a blank virtual hard disk or copy the contents of an existing physical disk.
Choose Disk Format (@) Create a new blank virtual hard disk
Choose Disk Type Size: GB (Maximum: 54 TB)
Spedfy Mame and Location
(") Copy the contents of the specified physical disk:
Summary Physical Hard Disk Size
A\ PHYSICALDRIVED 930 GB

(") Copy the contents of the spedified virtual hard disk

Path:

m
(=]
i
i

< Previous Next> | | Finish Cancel

10. Set the Disk Size based on the license you have acquired and then click Next. The minimum recommended sizes
are the following:

s EXNV-VM Small: 250 GB Total (Add a 200GB Disk)

s EXNV-VM Medium: 250 GB Total (Add a 200GB Disk)

s EXNV-VM Large: 500 GB Total (Add a 450GB Disk)

s+ EXNV-VM Extra Large: 500 GB Total (Add a 450GB Disk)

s EXNV-VM Extra Extra Large: 500 GB Total (Add a 450GB Disk)

6. Click Finish to create the hard drive. This can take a few minutes.
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5_*"_| Settings for exinda-v7.4.2-4118-x85_84 on HYPERV-2012-R2 - x

| exinda-v7.4.2-4118-x86_64 “ 4 b |Q
% Hardware (e —a Hard Drive
‘“ﬂ Add Hardware
A BIOS You can change how this virtual hard disk is attached to the virtual machine. If an
= Boot from €D operating system is installed on this disk, changing the attachment might prevent the
- ot irom virtual machine from starting.
Memory . N
2096 MB Controller: Location:
@ [ Processor IDE Controller 1 v| |1 (nuse) v
2 Virtual processors Media
(= &£ IDE Controller 0 You can compact, convert, expand, merge, reconnect or shrink a virfual hard disk
® a Hard Drive by editing the assodated file. Specify the full path to the file.
exinda-w7.4.2-4118-x86_6... @ Virtual hard disk:
&% DVD Drive - - - -
exinda-v7.4.2-4118-x36 6... |C:\JJsers‘Fubllc‘anmments"Hwer-‘a’\"-’rrh.ral Hard Disks\Exinda-New-Drive. vhd::]
= IDE Controller 1 ~ | I Edit ] 1 Tepect | o, I
£ 4 DVD Drive A ,
Mara Physical hard disk:
# a Hard Drive
Exinda-Mew-Drive. vhdx l =
& SCSI Controller @ 1f the physical hard disk you want to use is not ksted, make sure that the
® U Management disk is offiine, Use Disk Management on the physical computer to manage
Mot connected physical hard disks.
# O Extra , o . ,
Not connectad To remove the virtual hard disk, dick Remaove, This disconnects the disk but does not
delete the assodated file,
# 0 Lan
Mot connected | Remove
® O wan
Mot connected
7 com1
exinda-9e5f518b-12ac-4547-5...
7 com2
Mone
| Diskette Drive
Mone
% Management w

I 0K I Cancel . Apply

7. When the Hard Drive settings page for the newly created drive opens, click OK.

8. Start the virtual machine. When the VM starts, it will automatically recognize the new drive, but the new storage must
be manually added the virtual appliance.

NOTE

Before connecting, the management interface must already have been configured with an IP address or will obtain
an IP address using DHCP. You need to make sure that the Management Interface is connected to the proper Virtual
Switch in your Hyper-V environment.

9. Find the IP address assigned to the management interface by right-clicking on the VM and selecting the Connect
option. This provides console access.

10. Log on to the appliance using the default credentials (username: admin, password: exinda). You might need to
accept the EULA before proceeding.
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11. Apply the following commands. The output contains the IP address you need to access the appliance web user inter-

face.
exinda> en
exinda># show int ethO

12. Connect through HTTPS to the Exinda appliance using a browser.

13. Once logged on, click Configuration > System > Setup > Storage.

14. Add the new drive.

NOTE

The following screenshot assumes that the chosen controller was 1,and the location was 0, so the new drive is sdd.

Configuration System Setup

Traffic Policies

Optimizer Modify Exinda appliance disk storage settings.

Users & Groups

Before changing the size of a partition, you must remove Ihe encryption on the partition and put the appliance into Bypass mode.

Objects Disk Storage Map.
enwork mﬁ

Optimization

sdb  unused 214768
. sdcld  inuse 2872 GiB Remove

Authentication

Logging l sdd in-use 200.00 GiS I Add I

Diagnostics Refresh Disk Information

Certificates

VLANS Storage Configuration
Protocols Service Status Free Size Minimum  Encrypted Operation
Applications cifs available  SI7.65M  96% 5340000 1024.00M ]
Schedules edge.cache  awailable  2I8437M  95% 3504007 to2400M
Adaptive Response monitor available  9657.20M  94% 0006  10.00G
Service Levels sallibie  S7462M 9% s1z.00M
HTML Response
P wanmemory  ovdiloble  BI6B84M 97 sassoon] swoooM  H [Encryes]
unallecated storage 200.00G
System i
Total Available Storage: 287G
Basic Install wizard
Network Disk Configuration
Setup Disk  Status Size  Operation
=da in-use

e I [ e e e e e e [ e

Maintenance

Tools

The new space appears as “unallocated storage” inside the “Storage Configuration” section.

NOTE

Exinda recommends that you resize the “monitor” partition to at least 100GB. If you are licensed for acceleration, you
should allocate most of the remaining storage in "wan memory" partition (cache partition for all TCP protocols), but if
you are accelerating CIFS/SMB protocols, allow some storage in the "cifs" partition.

15. Allocate the storage as appropriate.

Related Topics
»  Adjusting the number of CPUs available to the Virtual Machine
# Adjusting the RAM available to the Virtual Machine

#  Adjusting the NICs available to the Virtual Machine

Exinda Network Orchestrator



0.41 Customizing a Hyper-V Virtual Machine

As supplied, the Exinda Virtual Appliances will require some configuration changes before you introduce them to your
network. For example, the virtual hard drives are limited to 50GB, which would be unlikely to be sufficient for your needs.
The virtual machines available are sized with minimal configuration as it is not possible to know just what hardware is
available on any host machine. To edit the configuration, you need to open the settings for the virtual machine in the
Hyper-V Manager.

There are many settings that you can change, but for the purposes of configuring the Exinda Virtual Appliance, these
task instructions are limited to what is necessary for bringing the appliance into an operational state. If you need more
information, please consult the documentation for Hyper-V. This topic deals with changes to the configuration related to
the number of CPUs, the available RAM, the NICs, and adjusting the storage for the virtual machine.

The configuration changes are required before your initial use of the virtual machine. You can also make further changes
to your virtual machine at any later time. If over time you require more resources for the virtual machine, as long as those
resources are available on the host, you can make them available to the guest.

Related Topics

B

+ Adjusting the number of CPUs available to the Virtual Machine

e

» Adjusting the RAM available to the Virtual Machine

e

+ Adjusting the NICs available to the Virtual Machine

# Increasing the size of the virtual hard drive
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Running on Linux KVM

KVM (Kernel-based Virtual Machine) is a complete virtualization solution for Linux on x86 hardware.

It contains virtualization extensions (Intel VT or AMD-V) and a loadable kernel module, kvm.ko. This provides the core
virtualization infrastructure; and a processor specific module kvm-intel.ko or kvm-amd.ko.

By using KVM, you can run multiple virtual machines running unmodified Linux or Windows images. Each virtual
machine has private virtualized hardware: a network card, disk, graphics adapter, etc.

See the following for more information:

0.42 Installing KVM on Dedicated Hardware

Learn to install KYM on dedicated hardware with Ubuntu server.
You can Install KYM by running the below command:

sudo apt-get install gemu-kvm libvirt-bin virtinst bridge-utils cpu-
checker

Verify that KVYM is correctly installed by running the below command:
kvm-ok

If you get the below output then the server hardware is capable of running virtual machines. If not, you have to enable
this from the BIOS.

INFO: /dev/kvm exists

KVM acceleration can be used

0.43 Network Setup

Learn to setup the network

The network setup depends on a particular configuration. Bridges are used in KYM to add network interfaces to a
particular VM. Each Exinda appliance requires at least 2 network interfaces.

0.44 Installing the VM

Toinstall the VM, run the below command:
sudo virt-install \
--virt-type=kvm \

--name <EXINDA VM NAME> \
—--ram 4096 \

--vcpus=2 \
--os-variant=centos6.3 \
—--virt-type=kvm \

——hvm \

--cdrom=<PATH TO ISO> \
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--network=bridge=<BRIDGE 1>,model=virtio \
--network=bridge=<BRIDGE 2>,model=virtio \

--disk path=/var/lib/libvirt/images/<EXINDA VM
NAME>.gcow2, size=40,bus=virtio, format=gcow?2

The above command will create the VM and also allocate the disk stored in gcow?2 format.

Note
You can get the installation media ISO from your Exinda partner.

The domain might take some time to be created, as the script that installs Exinda OS is being executed. You can view the
progress by opening another console and running the below command:

sudo sudo virsh console $VM ID

Where $VM_ID isthe unique identifier for the running VM. You can view running VMs by running virsh list
andvirsh list --all forall VMs (started and stopped).

Note
For Autostartrun, sudo virsh autostart $VM ID.

0.45 Learn to Configure Exinda

To configure Exinda from the console you can attach to the VM console using the below command:
sudo sudo virsh console $VM ID

Alternatively, you can use the web browser and access the Exinda configuration through the web GUI.
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